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CHAPTER I 

 

INTRODUCTION 

 

1.1 Introduction 

Composite I-girder steel bridges, as shown in figure 1.1, are commonly used in many 

countries. These bridges face the problems such as corrosion and fatigue that reduce a 

bridge’s service life (Nishikawa et al. 1997; Jajich and Schultz, 2003).    

 

 

Figure 1.1 Composite I-girder bridges at intersections in Thailand 

 

There are two types of elements in composite I-girder bridges. The first type 

includes the primary elements such as girders, concrete slab (concrete deck), and 

supports, while the secondary elements consist of the cross bracings, diaphragms, and 

parapets. The concrete deck and steel girders form the composite structural system.  

They are typically connected by shear studs embedded in the concrete and tied 

together by diaphragms or other horizontal bracings, as shown in figure 1.2. 

Diaphragms or horizontal bracing are intended to resist lateral load and to help 

distribute traffic loading. Additionally, the diaphragms stabilize the girders against 

lateral buckling during construction before the concrete deck is poured and hardened. 
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(a) 

 

(b) 

Figure 1.2 Typical cross section of Wongsawang composite I-Girder bridges  

(a) Diaphragm (b) Cross frame 

 

Figure 1.3 shows rigid body rotations of diaphragms that connect adjacent girders due 

to the differential deflection between adjacent girders (Δ). This causes a torsional 

moment in the girders and a flexural moment in the diaphragm. 

 

Figure 1.3 Differential deflection of adjacent girder 

 

 

Out of plane moment = M 

Girder spacing = S 

M 
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The transverse stiffeners connecting the diaphragm and girder are rigidly 

welded to the girder web. It causes the latter to take up the majority of the out-of-

plane displacement and rotation which is more critical when the transverse stiffeners 

terminate a few inches from girder flange. The space between the transverse stiffeners 

and the girder flanges is called the “web gap” (see figure 1.4). The unstiffened web 

gap region attracts the majority of this out-of-plane distortion because of its relative 

flexibility. When the out-of-plane stress is higher than the stress capacity of girder 

web, crack can be occur in the end of stiffener as shown in figure 1.5 or above the 

bottom flanges. 

 

                          

     (a) (b) 

Figure 1.4 Web-gap on web girder of Wongsawan bridge (a) at diaphragm  

(b) at cross frame 

 

 

Figure 1.5 Schematic of web gap stress in the end of stiffener (Fisher, 1978) 

 

 

web gap 
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Due to the presence of concrete slab in the superstructure of composite I-

girder bridge, the live loads are not applied directly to the beam. In view of this, the 

concept of distribution factor is needed to determine the maximum shear and 

moments of girders under the live load. Then the maximum shear and moments in 

beams caused by the given live load will be multiplying with the appropriate load 

distribution factor to obtain the critical live load shear and moment in girders.  

Load transfer from concrete slab to steel girder is a three dimensional problem and 

involves complex behavior. The AASHTO bridge specifications suggest several 

methods for analysis such as finite element analysis, grillage analysis, and lateral load 

distribution factor equation. Currently, the lateral load distribution factor of the live 

load moment in highway bridge design is commonly determined using the method 

from AASHTO LRFD standard specification (1996, 1998).  Bridge parameters that 

influence the lateral load distribution factors include girder spacing, span length, slab 

thickness, modular ratio between steel and concrete, girder stiffness, girder area, and 

eccentricity between centroids of girder and slab.  

1.2 Motivation / Research Significance 

The motivations of this research are: 

1. To understand the mechanism of distortion induced stress in the web gap area of 

composite steel I girder bridges. 

2. To review the bridge parameters that influence the lateral load distribution of 

composite steel I-girder bridges. 

3. To find the bridge parameter that influence the distortion-induced stress 

4. To study the relationship between distortion-induced stresses and lateral load 

distribution. 

 

1.3 Objectives 

The objectives of this research are: 

1. To investigate the effects of bridge parameters on distortion induced stresses 

2. To investigate the effects of bridge parameters on lateral load distribution factor. 
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1.4 Scope of Works 

The scopes of this research are: 

1. The number of girders in composite I-girder bridges is three. 

2. Truck types include AASHTO HS20-44 ad Thai truck. 

 

1.5 Methodology 

Methodologies of the research are: 

1. Perform the literature review on the bridge parameters that influence the lateral 

load distribution and the distortion-induced fatigue. 

2. Using SAP2000, implement the finite element analysis of composite I-girder steel 

bridges to determine LDF and distortion-induced stress in the web gap area. The 

global finite element model will be validated with field test data. 

3. Perform a parametric study on the relative girder deflections and distortion-

induced stress. 

4. Derive the formula for the relative displacement and out-of-plane stresses as a 

function of bridge parameters and truck loadings. 

5. Prepare a research report and technical paper for publication. 

 

 



CHAPTER II 

 

LITERATURE REVIEW 

 

 

The technical literature documented past problems associated with damage 

from distortion-induced fatigue in steel bridges. There are two main categories of this 

technical literature documentation. The first category is the most previous research, 

includes field observation of the causes of distortional stresses, extent of fatigue 

damage and characteristics common to affected bridges. The second category 

explores the sources of distortional stresses used laboratory experiments. Both 

research categories has prompted design code changes and proposed design guidelines 

for future structures. The understanding of the nature and severity of the distortional 

fatigue problem was improved from the research documented in the literature, and the 

observations have provided guidance on the maintenance and design of composite I-

steel girder bridges. Computer finite element model analysis was also used to observe 

the susceptible details and to provide information about repair investigations and field 

tests. 

 

2.1 Lateral Load Distribution 

An important issue of bridge design is lateral load distribution factor. It shows 

the maximum moment and shear of each girder due to live load in the concrete slab. 

The effect of bridge parameters on lateral load distribution factor is critical in order to 

know the maximum moment distribution in the bridge structure. The maximum 

moment in a girder is obtained by multiplying the moment from a one-dimensional 

bridge analysis by the value obtained from the LDF equation. 

Since the 1930s, the AASHTO simple S/D formula has been used for live load 

distribution factors in most common case, where S = girder spacing and D = a 

constant that depends on the type of the bridge superstructure and the number of lane 

loaded. It can be found in AASHTO’s Standard Specification (AASHTO, 1996). LDF 

for concrete slab on steel girder with two or more design lanes loaded is: 
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5.5

S
LDF   (US customary unit) 

(2.1)

1676

S
LDF   (SI unit) 

where S = girder spacing. 

The above formula shows the valid results only for typical geometry but loses 

its accuracy when the bridge parameters are varied. In addition, the formulas do not 

include the effects of bridge skewness (Zokaie 1991).   To improve the S/D formula, 

The National Cooperative Highway Research Program (NHRCP) 12-26 project 

develops the AASHTO-LRFD (AASHTO 1994) live load distribution. Additional 

parameters that were included in this new formula are the bridge span (L), slab 

thickness (ts), girder spacing (S), and longitudinal stiffness parameter (Kg). But it 

should be realized that the formulas were developed based on the models with 

uniform girder spacing, beam inertia, and skew angle. The continuous models with 

equal spans and the diaphragm effects are not included in this study. 

Mabsout el al (1997) obtained the lateral load distribution factor by dividing 

the maximum moment from finite element analysis model by the maximum moment 

found in simply supported beam. Using the same methods, Zokaie (2000) presented 

the formula for moment distribution to interior girders in bridges with two or more 

lanes: 
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Where S = girder spacing (mm); L = span length (mm); Kg = n (I+Ae2) = longitudinal 

stiffness (mm4); ts = slab thickness (mm); n = modular ratio between steel and 

concrete; I = girder stiffness (mm4); A = girder area (mm2); and e = eccentricity 

between centroids of girder and slab (mm). 

AASHTO LRFD specification (1998) introduced lateral load distribution 

factor for all type of the bridge. This equation based on finite element and statistical 

analysis of the large number of bridges. The LDF for interior girder with two or more 

lanes for beam and slab bridges is given by 
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Where S = girder spacing (mm); L = span length (mm); Kg = n (1+Ae2) = longitudinal 

stiffness (mm4); ts = slab thickness (mm); n = modular ratio between steel and 

concrete; I = girder stiffness (mm4); A = girder area (mm2); and e = eccentricity 

between centroids of girder and slab (mm). 

Lateral distribution factor above only can be used for type of bridge with 

concrete deck, filled grid or partially filled grid on steel or concrete beams, concrete, 

concrete T-beams, T- and double T- section. 

The equation above is applicable for the bridge with width between 1100 mm 

and 4900 mm, length of the bridge is between 6 m and 73 m, and the slab thickness 

between 110 mm and 300 mm.  

Sotelino et al (2004) proposed a new simplified LDF equation, based on the 

AASHTO LRFD LDF equation, and the longitudinal stiffness parameter included 

through its relationship to the span length: 









000,180

exp042.015.0
3.0

8.0 L

L

S
LDF  (2.4) 

where S = girder spacing (mm) and L = span length (mm). 

Another simplified method was developed for the calculation of the 

distribution factors of live load moment by a former engineer of the Structure 

Division of the Tennessee Department of Transportation (TDOT), namely Henry 

Derthick. This method was used in Tennessee since 1963 where it requires only the 

information on the width of the roadway, number of traffic lanes, number of beam 

lines, and the multiple-presence factor of the bridge. The LDF from this method is 

very close to the AASHTO LRFD LDF equation in the variation of span length, beam 

spacing, slab thickness, and beam stiffness (Zhu et al. 2004) 

Another attempt to further develop these formulas was done by Phuvoravan 

(2006) when he studied the sensitivity of the LDF parameter. The purpose was to 

eliminate parameters for which the LDF is not as sensitive as others and also those 

that require iterative design procedure. From the results of this study, girder spacing 

and span length was found to influence the LDF value, while the slab thickness and 

the longitudinal stiffness parameter could be eliminated. The new simplified formula: 
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16.0

8.0

85
15.0

L

S
wg   (2.5) 

where S = girder spacing (mm) and L = span length (mm). 

The parameters used in the study include those given in the lateral load 

distribution factor (LDF) equation (AASHTO, 1998). The LDF equation for beam and 

slab bridges with two or more lanes is: 

1.0

3

2.06.0

2900
075.0 
























s

g

Lt

K

L

SS
LDF  

  

(2.6)

where S = girder spacing (mm); L = span length (mm); Kg = n (I+Ae2) = longitudinal 

stiffness (mm4); ts = slab thickness (mm); n = modular ratio between steel and 

concrete; I = girder stiffness (mm4); A = girder area (mm2); and e = eccentricity 

between centroids of girder and slab (mm). The above equation is applicable for the 

bridge having the width between 1100 mm and 4900 mm, the length between 6 m and 

73 m, and the slab thickness between 110 mm and 300 mm.  

 

2.2 Out-of-Plane Bending Mechanism 

Since live loads in the bridges do not distribute uniformly to the entire slab, 

there is a difference in displacement between adjacent girders. The differential 

vertical displacement between adjacent girders can cause the torsional moment on the 

girder and rotation of the diaphragm. Assuming that the connection between girder 

and concrete slab are rigid, the flexural moment in the connection between girder and 

diaphragm can be calculate when the relative displacement of the girder is known.  

Repetitive live loads especially heavy vehicles causes fatigue crack damage in welded 

areas subjected to secondary or distortion-induced fatigue (Nishikawa et al. 1998). 

Figure 2.1 shows a fatigue crack in the web gap area. 
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Figure 2.1 Fatigue crack in the web gap near bottom flange of a girder (Zhou, 2005) 
 

The field measurement data from Cousin et al. (1998) shows that the stress 

occurring in the connection plate to the web welds and flange radius on the original 

welded connections are large enough to cause fatigue cracking. The fatigue cracking 

was caused by out-of-plane distortion usually occurring at locations where transverse 

structural components such as floor-beams, diaphragms and cross-frames are 

connected by connection plates to the longitudinal girders (Roddis and Zhao, 2001). 

In Japan, the most common cracks occur at the top end of vertical stiffener welded to 

the top flange. Some web cracks also exist at the fillet-weld toe connecting the web 

and the top flange of the main girder. These cracks were caused mainly by secondary 

stresses due to both the relative deflection of the main girders and the deflection of the 

RC deck by the wheel load of heavy traffic (Nishikawa et al, 1998). 

Jajich and Schultz (2003) give a simple technique for predicting web-gap 

stress using the basic concepts for linear, elastic systems, as shown in figure 2.2. 

Treating the web gap as a beam that is fixed at both ends and undergoing rotation at 

one end, the maximum moment at the base of web gap gEIM wgwg
4  is obtained, 

where E = modulus of elasticity;  Iwg = moment of inertia of web gap section resisting 

out-of-plane bending; and g = web-gap length. Hence, the maximum stress at the 

stiffener end of the web gap is wgwwgwg ItM5.0  where tw = web thickness. 

Combining these expressions and substituting the diaphragm rotation L  where L 

= length of diaphragm and Δ = displacement adjacent girder, gives the maximum web 

gap stress as a function of girder differential deflections    LgEtwwg  2 . 
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(a) (b) 

 

Figure 2.2 Schematic representation of web gap rotation (a).web-gap rotation 

(b).diaphragm rotation (Jajich and Schultz, 2003) 

 

Figure 2.3 shows the diaphragm rotation and the web gap deflection according 

to Fisher et al (Li and Schultz, 2005), web gaps are postulated to behave much like 

short, fixed-fixed beams undergoing lateral deflection, δ , without end rotations. 

Neglecting the component of stress due to rotation at one end of the web gap under 

this assumption, the maximum out-of-plane web gap stress, σwg, is 







 










S

h

g

Etw
wg 2

3  (2.7) 

where E is Young’s Modulus, tw is the thickness of the web, h is the depth of the 

diaphragm, S is the girder spacing, g is the length of the web gap and Δ is the 

differential deflection between adjacent girders, as shown in figure below. 

 

Figure 2.3 Diaphragm rotation and the web gap deflection according to  

Fisher et al.(1990) 

L 

H 

Δ 

θ = Δ/L
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The amount of differential deflection between two adjacent girders, Δ, cannot 

be easily predicted because the transverse interaction of concrete decks, 

reinforcement, girders, and diaphragms are difficult to predict without detailed finite 

element analysis. Berglund and Schultz (2006) investigated the parameter which 

significantly causes girder differential deflection. Generally, differential deflection 

decreases as the bridge span length increases but increases as the angle of skew 

increases, and increases with larger girder spacing.  

 

2.3 Previous Finite Element Models 

Mabsout et al. (1997) used four finite-element models to evaluate the wheel 

load distribution factors of steel bridges with different span length and girder spacing. 

They obtained the lateral load distribution factor by dividing the maximum moment 

from finite element analysis model by the maximum moment found in simply 

supported beam. In the first finite element model, concrete slabs were idealized as 

quadrilateral shell elements and the steel girder was idealized as space frame member, 

as shown in figure 2.4. The second model was similar to the first model, but the rigid 

links were imposed to accommodate the eccentricity of the girders with respect to the 

slab. Figure 2.5 shows the third finite element model with idealizes the concrete slab 

and the girder web as quadrilateral shell elements. Girder flanges were modeled as a 

space frame elements, while flange to deck eccentricity was modeled by imposing a 

rigid links. The first, second, and third were generated by program SAP90. The fourth 

finite element model was developed and analyzed using the general computer 

program ICES-STRUDL II. The concrete was idealized using isotropic eight node 

brick element and the steel girder flanges and webs were modeled using quadrilateral 

shell element. The load distribution factor for steel girder bridges correlates well with 

the first and fourth finite element model.  
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Figure 2.4 First finite element model (Mabsout el al.1997) 

.  

Figure 2.5 Third finite element model (Mabsout el al.1997) 

 

Chaisomphob and Lertsima (2000) study generated bridge model using the 

finite element package called MARC. The quadrilateral four-node plate element was 

used to idealize orthotropic steel deck, concrete slab, and the steel girder including all 

stiffeners. The rigid link element was used to take into account the eccentricity 

between middle plane of concrete slab and steel flange plate of the girder. 

Roddis and Zhao (2000 and 2003) presented the stick frame analysis and finite 

element method for modeling a bridge. The stick frame analysis was used to obtain 

the girder displacement. It was generated by using STAAD/Pro 3.1. The ‘cut out’ 

floor beam or truss frame to girder web was modeled using finite element program 

ANSYS 5.6 with the displacement from stick frame analysis as a loading. The finite 

element model is shown in figure 2.6 and figure 2.7. 
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(a) 

 

(b) 

Figure 2.6 Finite element model (a) Stick frame model (b) ‘cut out’ truss frame to 

girder web model (Roddis and Zhao, 2000) 

     

              (a)                              (b) 

Figure 2.7 Finite element model (a) Stick frame model (b) ‘cut out’ truss frame to 

girder web model (Roddis and Zhao, 2003) 
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Jajich et al. (2000) and Jajich and Schultz (2003) performed a linear finite 

element study of a diaphragm-stiffener-web connection. A three dimension finite 

element model was created using SAP2000. All portions of steel (web, flanges, 

diaphragm, and stiffeners) were represented by shell element as shown in figure 2.8. 

The model consists of two adjacent girders connected by diaphragm. All dimensions 

were taken either directly from the bridge or from the design plan. The concrete deck 

was excluded in the model, but the rotational fixity of girder top flanges due to the 

presence of the deck was assumed.  The vertical displacement from truck test data 

was applied to obtain the web gap strain. The mesh in the web gap area was refined to 

get better result, as shown in the deformed shape in figure 2.9. 

 

Figure 2.8 Finite element model (Jajich et al. 2000)  

 

Figure 2.9 Deformed shape of web gap and stiffener (Jajich et al. 2000)  
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Huo et al (2004) used the finite element program ANSYS 5.7 to model the 

steel I-beam bridges. The deck slab was modeled by the four-node shell element with 

six degrees of freedom per node. The shell elements accounted both membrane and 

bending stiffness, including in- and out-of-plane bending. The longitudinal beams 

were modeled by three-dimensional two node beam element with six degree of 

freedom per node. The slab shell element was directly above the beam which is 

integrated to account for the composite action. The finite element model was used to 

obtain the LDF defined as the ratio of moment from finite element model and moment 

from single beam loaded by truck axle load. 

Schultz and Li. (2005) use the truck loads reported in Jajich and Schultz 

(2003) field tests were simulated and applied to a so-called macro model, as shown in 

figure 2.10. The model included the entire bridge and a portion of the bridge 

surrounding the diaphragm to determine the deformations to be imposed on the bridge 

micro-model. Deck rotation and diaphragm deflections from macro-model finite 

element analyses were applied as boundary conditions for the micro-model finite 

element analyses at the locations where these members were disconnected from the 

rest of the bridge. Figure 2.11 shows the girder top flanges and the portion of the 

concrete deck connecting the two girder segments in the micro model as shell 

elements and connected by rigid elements at closely spaced intervals. The deck 

boundary was fixed against translation along the edges parallel to the girders. Girder 

differential and deck rotations from macro-model were applied to the micro-model to 

determine the web-gap movement and stress field. 

 

Figure 2.10 Macro model (Li and Schultz, 2005) 
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Figure 2.11 Micro model (Li and Schultz, 2005) 

 

Another’s commercial finite element software, ABAQUS was used by some 

researchers to model a steel I-beam bridge, as shown in figure 2.12, 2.13, and 2.14. 

The concrete deck was modeled by eight node shell element (ABAQUS S8R), while 

the steel girder is modeled by three nodes Timoshenko beam element (ABAQUS 

B32/B33). The full composite action between the centroid of the girder and the 

midsurface of the slab was modeled by rigid links (ABAQUS MPC). The bearing was 

modeled by assigning boundary conditions to the grounded spring elements 

(ABAQUS SPRING1) (Sotelino et al. 2004; Phuvoravan, 2006; and Chung et al, 

2006) 

 

Figure 2.12 Finite element model (Phuvoravan, 2006) 
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Figure 2.13 Finite element model (Chung et al, 2006) 

 

Figure 2.14 Finite element model (Sotelino et al, 2004) 

Chung and Sotelino (2005) investigate the finite element model of composite 

bridge using ABAQUS. Four girder’s modeling techniques were generated and 

comparison in displacement incompatibility and geometric modeling errors was 

investigated. The G1 model is a detailed model of a steel girder. The flanges and the 

web are modeled by shell elements as shown in figure 2.15 (a). The next model, G2, 

is similar to the G1 model except that the flange is modeled by beam elements instead 

of shell elements, as shown in figure 2.15 (b). As shown in figure 2.15 (c), the G3 

model is proposed here to investigate the possible incompatibility at the element 

connection between web and flanges found in the previous two models. The G4 

model is the simplest model and utilizes beam elements with the geometric properties 

of girder sections. This model is shown in figure 2.15 (d). 
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(a) (b)           (c)        (d) 

Figure 2.15 Girder’s model techniques (Chung and Sotelino, 2006) 

The study result the beam model (d) has been identified as the most 

economical model among all studied models, since this model is capable of accurately 

predicting the flexural behavior of girder bridges, including deflection, strain, and 

lateral load distribution. 

Berglund and Schultz (2006) used SAP2000 Nonlinear to create a three 

dimensional model of the entire bridge with shell element was selected to idealize 

deck and girder webs and frame elements chosen to modeling girder flanges and 

integral concrete edge rails. Rigid links were used to connect members meant to 

exhibit composite behavior. As shown in figure 2.16, girder webs were modeled with 

two shell elements providing the joints on which the diaphragms could be connected. 

Deck mesh discretization was modified between different bridge models to 

accommodate the exact lateral location for lane loading. 

 

Figure 2.16 Partial cross section through FE model (Berglund and Schultz 2006)  



CHAPTER III 

 

THEORETICAL BACKGROUND 

 

3.1 Introduction to Fatigue 

Most of the structural components subjected to repeated fluctuating loads 

whose magnitude under monotonic loading is way below the fracture load.  The 

process cumulative damage in environment that is caused by this load is called 

fatigue. Fatigue damage of the components subjected to normally elastic stress 

fluctuations occurs at regions of the stress (strain) raisers where the localized stress 

exceeds the yield stress of the material. After a certain number of load fluctuations, 

the accumulated damage causes the initiation and subsequent propagation of a crack, 

or cracks in the plastically damaged regions. The parameters affecting the fatigue 

performance include stress (load), geometry, and properties of the component, and 

external environment (Barsom and Rolfe, 1999). 

LRFD Specifications categorizes fatigue as either “load induced” or 

“distortion induced”.  Load induced is a “direct” cause of loading. Distortion induced 

is an “indirect” cause in which the force effect, normally transmitted by a secondary 

member, may tend to change the shape of, or distort, the cross section of a primary 

member.  

3.1.1 Load-Induced Fatigue 

LRFD Article 6.6.1.2 provides the framework to evaluate load-induced 

fatigue. Load-induced fatigue is determined by the following: 

1. the stress range induced by the specified fatigue loading at the detail under 

consideration; 

2. The number of repetitions of fatigue loading a steel component will experience 

during its 75-year design life. This is determined by using anticipated truck 

volumes; and 

3. The nominal fatigue resistance for the Detail Category being investigated. 

LRFD grouping details that is vulnerable to load-induced fatigue into eight 

categories base on fatigue resistance.  
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3.1.2 Distortion-Induced Fatigue 

LRFD Article 6.6.1.3 provides specific detailing practices for transverse and 

lateral connection plates intended to reduce significant secondary stresses that could 

induce fatigue crack growth. The provisions of the LRFD Specifications are concise 

and direct requiring no mathematical computation. 

Out of plane distortion-induced stresses are not quantified in the AASHTO 

design code. Unless appropriate finite-element analysis or field testing is conducted, 

secondary stress cannot be determined because the connection stiffener to girder 

flange and web intersection is under complex, three dimensional structural interaction, 

and the local geometry and relative stiffness of this detail are different for individual 

bridge (Roddis and Zhao, 2003). 

3.2 Finite Element Types 

This research is using SAP2000 (Computer and Structure, 2000) to construct 

the finite element model. SAP2000 is a general civil engineering finite element 

analysis package developed by Computers & Structures Inc. 

3.2.1 3D Beam Element 

3D element bar allows six degrees of freedom per node, three translations and 

three rotations as shown in figure 3.1. The w and θy degree of freedom account for 

lateral deflection in the zx plane. The θx is degree of freedom account for twist about 

the x axis. Which the stiffness coefficient is GK/L, where K is a property of the shape 

and size of the cross section.  

 
 
 
 
 
 
 

 
Figure 3.1 Beam element on the x axis of a rectangular coordinate system (Computer 

and Structure, 2000) 
SAP2000 frame element uses as a general, three-dimensional, beam-column 

formulation includes the effects of biaxial bending, torsion, axial deformation, and 

biaxial shear deformation. A frame element is modeled as a straight line connecting 

two joints. Each element has its own local coordinate system for interpreting output 

z 
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and defining section properties and loads. It normally activates all six degrees of 

freedom at both of its connected joints.  

3.2.2 Shell Element 

A shell structure carries loads in all directions, and therefore undergoing 

bending and twisting, as well as in-plane deformation. The most direct way to obtain a 

shell element is to combine a membrane element and a bending element. The 

membrane elements handle the membrane or in-plane effects, while the plate elements 

are used to handle bending or out-plane effects. The resulting element is flat and 

locally has five or six degrees of freedom per node, depending on whether or not the 

shell normal rotation at node present in the plane stress element, as shown in figure 

3.2. 

 

a. Membrane element b. Plate element 

 

c. Shell element 

Figure 3.2 Degree of freedom (a) Membrane element (b) Plate element  

(c) Shell element (Computer and Structure, 2000) 

 

SAP2000 shell element is a three or four node formulation that combines 

separate membrane and plate-bending behavior. The membrane behavior uses an 

isoparametric formulation that includes translational in-plane stress stiffness 

component and a rotational stiffness component in the direction normal to the plane of 

the element. The plate-bending behavior includes two-way, out-of-plane, plate 
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rotational stiffness components and a translational stiffness component in the 

direction normal to the plane of the element. The shell element always activates all six 

degrees of freedom at each of its connected joints. Each shell element may have 

quadrilateral or triangular shapes. 

 

3.3 Multiple Linear Regression in Matrix Form 
 
The model of simple linear regression is 

iii XY   10   where i is independent N(0,2)  and i =1,…,n 

The model can be rewritten as  

11101   XY  

22102   XY  
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110   ni XY  

(3.1)

In matrix terms, let εXY  β , which is 
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Note         βββ XεEXEεXEYE   since E() = 0 and X are constants. 

It can be shown that β0 and β1 can be found from solving the “normal 

equations”: 
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The normal equations can be rewritten as YXXX TT  β , where 



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It was shown that  
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Thus, XTXβ = XTY can be written as  
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Suppose both sides of  YXXX TT β  are multiplied by   1XX' Then 

    YX'XXXXXX TTT 11 
β  

  YX'XX'I 1β  

  YX'XX' 1β  

Therefore, using matrix algebra,   YXXX TT 1
β   























































n

i
ii

n

i
i

n

i
i

n

i

n

i

YX

Y

XX

Xn

1

1

1

1

2

1
1

1
1

β  

 

  
  


























2

1

XX

YYXX
XY

i

ii


β  (3.8)

 

In order to validate the regression result, analysis of variance results is used. These 

can be rewritten using matrices:  
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CHAPTER IV 

 

FINITE ELEMENT STUDY 

 

4.1 Overview  

A linear finite element study of the bridge was undertaken to investigate the 

lateral moment distribution and differential deflection stress mechanism. The whole 

bridge was modeled in order to determine longitudinal moment in the girders and 

observe the stresses around web gap area. To accommodate both problems, dual level 

analysis was conducted. Two level of finite element analysis consist of global model 

as shown in figure 4.1, which is the modeled hole of the bridge, and submodel, which 

is a more detailed model of the bridge, was shown in figure 4.2. Both global model 

and submodel were studied using SAP2000 software package. 

 

 

Figure 4.1 Global model 
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Figure 4.2 Sub model 
 
 

4.2 Model Verification 

4.2.1 Field Test Data 

4.2.1.1 Bridge Dimension 

Field test data were collected from three highway bridges in Bangkok and all of 

them are a multi-girder composite I-girder. They are Prachanukul Bridge, 

Wongsawang Bridge, and Bangplad Bridge. However, the data from Wongsawang 

bridge were chosen in this study. The bridge span is 25 m with two traffic lanes and 

three girders. The concrete slab has a thickness of 200 mm with lane width 3.25 m. 

All three girders have the same dimension, built up wide flange 1450×450×12×22. 

This span has two types of lateral diaphragm, beam diaphragm and truss diaphragm as 

shown in figure 4.3. 
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(a) 

 

(b) 

Figure 4.3 Wongsawang bridge section (a) Beam diaphragm (b) Truss 

diaphragm 

Strain data from the strain gages in the bottom flanges near the connection 

between girder and transverse structure and web gap area were considered to verify 

the finite element model.  
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4.2.1.2 Truck Loadings 

In the field test, three cases of static loadings were applied to the bridge. The 

truck moved and stoped every 5 m along the bridge span. Three cases are one truck on 

left lane, one truck on right lane, and two trucks on both lanes with same longitudinal 

position, as shown in figure 4.4. Approximately 25 ton truck weight was used in this 

field test. Distribution of wheel load is shown in table 4. 1. 

 

Table 4.1 Truck Properties (Wongsawang In Bound) 
Truck Properties   Truck No. 1    
 
 
 

        
    Truck Dimension (m) Wheel Dimension 
    A = 1.93  X = 0.21 
    B = 4.17  Y = 0.33 

    C = 1.30  
 
 
 

33 
    D = 1.80  13  
       52  
    Weight (Tons)   
     Left Right Sum  
    Axle 1 3.005 3.005 6.01  
    Axle 2 4.900 4.900 9.80  
    Axle 3 4.675 4.675 9.35  
    Total 25.16 Tons 
                
Truck Properties   Truck No. 2    
 
 
 

        
    Truck Dimension (m) Wheel Dimension 
    A = 1.93  X = 0.20 
    B = 4.18  Y = 0.32 

    C = 1.30  
 
 
 

32 
    D = 1.85  11  
       53  
    Weight (Tons)   

 
 
 
 

   Left Right Sum  
    Axle 1 3.205 3.205 6.41  
    Axle 2 4.930 4.930 9.86  
    Axle 3 4.375 4.375 8.75  
    Total 25.02 Tons 
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Truck Properties   Truck No. 3    
 
 
 

        
    Truck Dimension (m) Wheel Dimension 
    A = 1.78  X = 0.21 
    B = 3.65  Y = 0.32 

    C = 1.33  
 
 
 

30 
    D = 1.70  9  
       53  
    Weight (Tons)   

 
 
 
 

   Left Right Sum  
    Axle 1 2.785 2.785 5.57  
    Axle 2 4.970 4.970 9.94  
    Axle 3 4.755 4.755 9.51  
    Total 25.02 Tons 
                

 

 

(a) 

 

(b) 

 

(c) 

Figure 4.4 Truck loading cases in the field test (a) one truck on left lane (b) one truck 
on right lane (c) two trucks on both lanes. 
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4.2.1.3  Field Test Data  

Static cases test results stresses in the girder’s bottom flange. The strain gages 

placed in ¼ span, ½ span, and ¾ span for the purpose of verifying the finite element 

model, static load results by a truck 10 m from the edge was considered, as shown in 

table 4.2.  

 

Table 4.2 Field test data  

Bridge Truck loading case 
Strain 

gage 

Stress result (MPa) 

G1 G2 G3 

Wongsawang 

Case (a) 

One truck on left lane 

¼ span 186 112 24 

½ span 242 144 38 

¾ span 122 0 26 

Case (b) 

One truck on right lane 

¼ span 44 114 168 

½ span 60 144 226 

¾ span 38 0 118 

Case (c)  

Two truck on both lanes 

¼ span 210 214 208 

½ span 274 280 290 

¾ span 150 0 160 

 

Web gap stress was also measured in field test. Because of the installation 

difficulties, the strain gage was placed around one inch from the end of stiffener, as 

shown in figure 4.5.  

         

 

 

 

 

 

 

 

Figure 4.5 Strain gage position in web gap area. 

 

 

 

 

Bottom flange 

Top flange 

1 inch 

S
tiffener
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4.2.2 Finite Element Model 

4.2.2.1 Global Model 

A three dimensional finite element model of the bridge was created using 

SAP2000 (Computer and Structures, 2000). A 25-m span of Wongsawang bridges, for 

which field test data were obtained, was modeled. This bridge has two types of 

transverse element, diaphragm as a beam element in the end and mid-span of the 

bridge and cross frame as a truss element in the quarter and third quarter span, as 

shown in figure 4.6. In the global model, the cross frame was modified to a beam 

element. The simple analysis is needed in order to replace the truss structure of cross 

frame with the frame structure having the appropriate displacement shape of the 

girder.  

  

 

  

Figure 4.6 Two types of cross frame (a) Truss cross frame (b) Space frame 

Figure 4.6(a) shows the cross frame of the bridge. A 1-ton static load is 

applied at the end of the truss. Direct stiffness method is used to determine the 

stiffness of the structure and the vertical displacement in joint A. This analysis only 

considers the vertical displacement since only this is applied in the model. 

Accordingly, the space frame, as shown in figure 4.6(b), must result the same value of 

vertical displacement.  Assuming that the displacement and the loading from both 

structures are similar, the stiffness must be also same with the moment inertia 

determined. The software MATLAB 7.0 was used to analyze. 

In this case, the cross frame between two girders is shown in Figure 4.7. The 

length for each member are L1= 2880 mm, L2 = 900 mm, and L3 = 3017.35 mm. The 

area of the section is Ad = 1269.95 mm2, Ah= 4101.94 mm2, and Av = 2000 mm2. 

Modulus of elasticity is 200000 MPa 

 

 

(a) (b) 

A

1

1

A
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Figure 4.7 Model of truss cross frame  

The cross frame structure has ten degrees or freedom, thus the stiffness of the 

structure becomes 10×10 matrix. The end supports of the structure are shown in 

Figure 4.6(a).  Support in the left edge causes degree of freedom numbers 1, 2, and 5 

to become zero. The reduced stiffness resulted to a smaller 7×7 matrix. The stiffness 

matrix of the cross frame, Kt, is 

 

  3
3

2

12

1

1 L

dA
L

L
hA
  3

3
212

1

L

A
LL d  

0 

3
3

2

12

1

L

A
L d





  3

3
212

1

L

A
LL

d

 

0 0 

3
3

212

1

L

A
LL d  

3
3

2

1
2 2

1

L

A
L

L

A dv 





  0 3

3
212

1

L

A
LL

d  
3

3

2

12

1

L

A
L

d








 0 

2L

Av  

0 0 2L

Av

 
0 0 0 

0 

3
3

2

12

1

L

A
L d





  

3
3

212

1

L

A
LL

d  0 3
3

2

1
1 2

1
2

4

L

A
L

L

A dh








  0 1

2

L

Ah

 

0 

3
3

212

1

L

A
LL

d  
3

3

2

12

1

L

A
L

d








 0 0 3

3

2

2
2

L

A
L

d   
0 

0 0 0 
1

2

L

Ah  0 1

2

L

Ah

 

0 

0 
2L

Av  0 0 0 0 
2L

Av  

Based on the equilibrium equation, if 1 ton load is applied in the DOF10 the 

displacement in the DOF10 is 0.7535 mm.  

1 

2 

3 

4 

5 
6 7 8 

9 10

L1 

L2 
L3 

1 

2 

3 

4 

5 

6 7 

Ah 

Ah Ah 

Av 
Av 

Ad 
Ad 

3 4 6 7 8 9 10 

3 

8 

6 

7 

9 

Kt = 



34 
 

Beam element was constructed to replace the cross frame. It was designed to 

have the same vertical displacement in one edge with the cross frame. Vertical 

displacement from analysis above was used to obtain the beam stiffness. Assume the 

beam with same length with L1, as shown in figure 4.8. 

 

 

 

Figure 4.8 Beam element  

The equilibrium of this equation is  

103
1

3
u

L

EI
P   (4.1)

With u10 equal to 0.7535 mm, load 1 T and 20000 MPa modulus of elasticity result 

the moment inertia of the beam 5.1831×108 mm4. With trial and error the I-beam 

section 450×190×14×26 (I = 5.182×108 mm4) was chosen to represent the truss cross 

frame section. 

Global model consisting of main girders, diaphragms, and cross frames were 

idealized as frame elements and the concrete slab modeled with quadrilateral shell 

elements. As shown in figure 4.9, all three main girders (G1, G2, and G3) were 

simply supported with 2.8-m girder spacing. The bridge dimensions and material 

properties were similar to those of the real bridge.  

 

 

 

 

 

 

 

 

 

 

Figure 4.9 Global model of Wongsawang bridge 
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In the composite bridge, concrete deck and steel girder was designed to work 

together as one structure. All degrees of freedom of the concrete deck were distributed 

to the girder by shear studs.  

Mabsout et al.(1997) and Chung and Sotelino (2005) used rigid links to 

idealize composite action of finite element model to accommodate the eccentricity 

between frame element and shell element as a concrete deck. This technique showed a 

good result for lateral distribution. The moment of the girder in this finite element 

model resulted to longitudinal stiffness of the structure consisting of the shell element 

and frame element working together. However, if shear studs do not work 100%, it 

means the longitudinal stiffness of the structure was reduced. The Wongsawang 

bridge has a concrete deck thickness of 200 mm and height of 1450 mm. Finite 

element model of this bridge used rigid link between shell element and frame element. 

Based on the real bridge design, the length of the links is 825 mm, as shown in figure 

4.10. 

 

 

 

 

 
 
 

Figure 4.10 Partial bridge section  

 

The field test data include the longitudinal stresses at the bottom flanges of 

girders G1, G2, and G3. The truck loading was idealized as point load vehicle load 

with similar value and configuration with the wheel truck in the field test, as shown 

from figure 4.11 to figure 4.13. All truck loading cases were modeled in multistep 

analysis that configures three cases of lane loading, as shown in figure 4.13 to figure 

4.15. For the field test, Truck 3 was applied in the left lane and right lane in case (a) 

and case (b), respectively and truck 1 in the left lane and truck 2 in the right lane was 

modeled in case (c). The lane width is 1.8 m. 

 

200 mm

1450 mm
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Fame element 

Shell element 
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Figure 4.11 Modeling of truck 1 

 

Figure 4.12 Modeling of truck 2 
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Figure 4.13 Modeling of truck 3 

 

 

Figure 4.14 Truck loading lane of one truck on left lane case (case a) 

 

 

Figure 4.15 Truck loading lane of one truck on right lane case (case b) 
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Figure 4.16 Truck loading lane of two trucks on both lanes case (case c) 

The accuracy of finite element model depends significantly on both the 

geometric meshes and the algebraic solvers (Wang et al. 2005). The generation of 

finite element meshes focused on providing good results which the minimal errors on 

their solutions. The error was used to construct an economic mesh of finite element 

model (Becker and Vexler, 2004). In this study, the case of two trucks on both lanes 

was used. The data was for comparison is when truck stops in 10 m from the support. 

It compared with four finite elements with different discrete of shell elements and 

frame elements. Four discrete types of finite element models are: Type A with 70 

frame elements and 160 shell element connected by 63 rigid links, Type B with 130 

frame element and 560 shell element connected by 123 rigid links, Type C with 250 

frame element and 2240 shell element connected by 243 rigid links, and Type D with 

370 frame elements and 5040 shell element connected by 363 rigid links, as shown in 

figure 4.17 to figure 4.20. all node in girders are connected to the slab nodes via rigid 

links (all degree of freedom are coupled). The longitudinal moment from frame 

element output can be analyze to obtain longitudinal stresses in the bottom flanges at 

midspan are compared. 
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Figure 4.17 Global model for sensitivity study Type A (293 elements) 

 

 

Figure 4.18 Global model for sensitivity study Type B (817 elements) 
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Figure 4.19 Global model for sensitivity study Type C (2773 elements) 

 

Figure 4.20 Global model for sensitivity study Type D (5772 elements) 

 

Sensitivity study shows that the longitudinal stress in the midspan decreases 

with increasing amount of shell and frame elements. Figure 4.21 to figure 4.23 shows 

the convergence of longitudinal stress in the bottom flanges in the midspan. Based on 

the convergence trends of finite element model result, the mesh in global model type 
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C with 2773 element shows the best mesh because global model type D does not give 

significant difference result.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.21 Longitudinal stress in G1 from sensitivity study result  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.22 Longitudinal stress in G2 from sensitivity study result  
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Figure 4.23 Longitudinal stress in G3 from sensitivity study result  
 

Four global models were constructed and compared with field test data. 

However, the comparisons show the discrepancy between the field test result and the 

finite element model result. Global model type C shows the result underestimates the 

field test data by 30%, it can be ensue because degree of composite action in the real 

bridge is not 100%. 

In this study, the modification of finite element model dimension was 

implemented in order to obtain the finite element model which is appropriate to the 

field test. The modification was needed in order to obtain smaller longitudinal 

stiffness. The way of modification is reduce the slab thickness until the height of the 

shear studs of the field test. This modification assumes the composite action is doing 

well in the height of shear studs or half of slab thickness, as shown in figure 4.24. 

 

 

 
 
 

Figure 4.24 Global model modification  

The modified finite element model results in higher longitudinal stress in the 

bottom flanges than unmodified model. The maximum difference between finite 

element model and field test data is 15%, as shown in figure 4.25. 
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Figure 4.25 Modified longitudinal stress comparison  

The vertical displacements of the girder from the modified finite element 

model were applied to the more detailed model, call submodel, in the next section. 

4.2.2.2 Submodel 

The second level model is called submodel, which is a detailed finite element 

model of the diaphragm-stiffener-web connection. Submodel consists of all shell 

elements. The portion of submodel is only half of girder span with full length 

diaphragm connect the girder, as shown in figure 4.26 (a).  The model consists of 

three girders, connected by a diaphragm, as shown in figure 4.26 (b). All dimensions 

were taken directly from the bridge itself or from the design plans. Top flange of 

girders is free to move in the vertical direction and rotate in the longitudinal direction. 

However, it is restrained against transverse rotation to simulate the restraining effect 

of concrete slab.  Vertical direction in the loading node is restrained to accommodate 

the applied displacement loading from the global model. At the support, the bottom 

flanges nodes are restrained in the longitudinal and transverse axis of the girder and 

free to move in longitudinal direction at the roller support. 

The vertical displacements of girders from global model were applied to the 

top of the girder flanges along the length of the submodel. It caused the shape of the 

girder represents the global model displacement.  
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(a) 

 
(b) 

 

Figure 4.26 Finite element model (a) Global model (b) Submodel 
 

The mesh in web gap area was refined in order to obtain local out-of-plane 

stresses. Because the size of the mesh in this area was much smaller than the mesh 

near the supports, a transition mesh was needed. To find the sufficient mesh, the 

convergence study is performed. The study used the case of one truck on left lane. 

Portion of sub-model 
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After the truck was applied in the global model, the vertical displacements in the 

girder in a portion of the submodel were applied to the top flanges in the submodel. 

Equal vertical displacement was applied to all the nodes in the same transverse 

direction in every longitudinal space.  

Four types of mesh were chosen in the sensitivity study. All finite element 

models were constructed based on the girder and diaphragm of Wongsawang bridge 

dimension. Each model has a varying local mesh in the web gap area. The four types 

of mesh are: Type A with 3808 shell elements, type B with 4198 shell elements, type 

C with 8638 shell element, and Type D with 29418 shell elements. Figure 4.27 shows 

the mesh in the web gap area for every type of submodel.  

  

(a) (b) 

(c) (d) 

Figure 4.27 Mesh of Submodel for sensitivity study (a) Type A (b) Type B 

 (c) Type C (d) Type D 

 The vertical stress distribution along the web gap length was studied. The 

coarse mesh results show a lowest of the stress in the top and bottom of web gap. As 

the mesh gets finer, the stress in the top and bottom of the web-gap increase. The 

result converges as the mesh is refined. Figure 4.28 and figure 4.29 show the vertical 
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stresses comparison of four types submodel. The stress in top of web gap was 

considered in this sensitivity study. As shown in figure 4.28, submodel type C and D 

shows the stress in the end of stiffener is converging.  
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Figure 4.28 Convergence of submodel 
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Figure 4.29 Stress distribution in vertical direction of web gap 
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Distribution of vertical stress along the length of web gap found was shown in 

figure 4.29. Submodel type D is found more suitable than type C. After the mesh of 

global model and submodel were identified, data from field test was used to verify the 

model. 

4.2.3 Verification of The Finite Element Model 

Model’s validation is a necessary requirement for model application. In this 

study, multistep analysis was performed to calibrate the global model. To calibrate the 

bridge model, a set of truck loads equivalent to the truck axle weight was applied as a 

vehicle on the lanes set earlier. Longitudinal stresses in quarter-span, mid-span, and 

third-quarter spans in every 5 m truck stops were considered for comparison. 

 

4.2.3.1 Global Model 

Three loading cases were applied to the finite element model. The comparison 

of longitudinal stress in the quarter-span, mid-span, and three-quarter-span in every 

truck loading cases in unmodified global model are shown in figure 4.30 to figure 

4.32.  

 

 

 

 

 

 

 

 

 

 



48 
 

Truck position

0 5 10 15 20 25

S
tr

es
s 

(M
P

a)

0

5

10

15

20

25

30

G1 field
G2 field
G3 field
G1 FEM
G2 FEM
G3 FEM

 

(a) 

Truck position

0 5 10 15 20 25

S
tr

e
ss

 (
M

P
a)

0

5

10

15

20

25

30

G1 field
G2 field
G3 field
G1 FEM
G2 FEM
G3 FEM

 

(b) 

Truck position

0 5 10 15 20 25

S
tr

es
s 

(M
P

a)

0

5

10

15

20

25

30

G1 field
G2 field
G3 field
G1 FEM
G2 FEM
G3 FEM

 

(c) 

Figure 4.30 Comparison of longitudinal stresses in the bottom flange of all three 

girders at quarter span from unmodified global model (a) One truck on left lane (b) 

One truck on right lane (c) Two trucks on both lanes 
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(c) 

Figure 4.31 Comparison of longitudinal stresses in the bottom flange of all three 

girders at midspan from unmodified global model (a) One truck on left lane (b) One 

truck on right lane (c) Two trucks on both lanes 
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(c) 

Figure 4.32 Comparison of longitudinal stresses in the bottom flange of all three 

girders at three quarter span from unmodified global model (a) One truck on left lane 

(b) One truck on right lane (c) Two trucks on both lanes 
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Figure 4.30 to figure 4.32 compare  the differences between global model 

and field test. Overall, the difference between finite element result and field test data 

results is very high (more than 20%) because the unmodified global model is stiffer 

than real bridge. 

In order to investigate the real bridge behavior, the modified global model was 

validated using the same field test data. The longitudinal stress comparison in 

modified global model is shown in figure 4.33 to figure 4.35. 

Truck position

0 5 10 15 20 25

S
tr

e
ss

 (
M

P
a

)

0

5

10

15

20

25

30

G1 field
G2 field
G3 field
G1 FEM
G2 FEM
G3 FEM

 Truck position

0 5 10 15 20 25

S
tr

e
ss

 (
M

P
a

)

0

5

10

15

20

25

30

G1 field
G2 field
G3 field
G1 FEM
G2 FEM
G3 FEM

 

  (a) (b) 

Truck position

0 5 10 15 20 25

S
tr

es
s 

(M
P

a
)

0

5

10

15

20

25

30

G1 field
G2 field
G3 field
G1 FEM
G2 FEM
G3 FEM

 

(c) 

Figure 4.33 Comparison of longitudinal stresses in the bottom flange of all three 

girders at quarter span from modified global model (a) One truck on left lane (b) One 

truck on right lane (c) Two trucks on both lanes 
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(c) 

Figure 4.34 Comparison of longitudinal stresses in the bottom flange of all three 

girders at midspan from modified global model (a) One truck on left lane (b) One 

truck on right lane (c) Two trucks on both lanes 
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(c) 

Figure 4.35 Comparison of longitudinal stresses in the bottom flange of all three 

girders at three quarter span from modified global model (a) One truck on left lane (b) 

One truck on right lane (c) Two trucks on both lanes 

The comparison in figures 4.29 to figure 4.35 shows that the maximum stress 

occurs in the girder G1 when the truck locates on the left lane, case (a), because the 

girder locates under the truck wheel position. The stresses in girders G2 and G3 are 

lower than the girder G1 depending on the lateral load distribution. Similarly, when 

truck on right lane girder G3 experiences the highest stress followed by G2 and G1. In 

case of two trucks on both lanes, case (c), all girders share approximately the same 

stresses. For the quarter-span longitudinal stress comparison, the maximum stress 

occured when the truck is on the quarter-span. Similarly, the maximum stresses on the 

mid-span and three-quarter-span occurred when the truck is on the mid-span and 

three-quarter-span, respectively. Lastly, the maximum stress in this bridge is obtained 

in the mid-span when truck position is in the mid-span. 
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  Figure 4.33 compares the longitudinal stresses in the bottom flanges of girders 

G1, G2 and G3 in the quarter-span from the finite element analysis with the field test 

data cases (a), (b), and (c), respectively. The maximum stress in the field test occurred 

when truck is around quarter span. In this position, the maximum differences are 20% 

and 25% for girders G1 and G2, respectively in case (a). In the case (b), the maximum 

differences are 25%  and 13% for girders G2 and G3, respectively. In the case (c), the 

difference is 19%, 20%, and 20% for girder G1, G2, and G3, respectively.  

Figure 4.34 shows the comparison of longitudinal stress of bridge finite 

element model and the field test in the mid-span. Similar to the quarter-span, the 

maximum stress in the field test occurred when truck is in midspan. In case (a), the 

maximum difference is 1% for girders G1 and 10% for girder G2. Case (b) obtained 

maximum differences with 8% and 2% for girders G2 and G3, respectively. In the 

case (c), the maximum difference is 8%, 10%, and 13%, for girder G1, G2, and G3, 

respectively. 

Comparison in figure 4.35 is between the longitudinal stresses of real bridge 

and finite element model in the three-quarter-span. The maximum stress in the field 

test occurred when the truck in three quarter span. 1.2% differences are shown in case 

(a) for girders G1. Case (b) rise maximum differences 2% for G3. In the case (c), the 

difference is 10% and 5% difference was occurred in G1 and G3.  

4.2.3.2 Submodel 

As mentioned above, the mesh in the submodel is refined in the web gap area, 

as shown in figure 4.36.  

 

Figure 4.36 Web gap area mesh 
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In order to validate with field test, the displacement shape of modified global 

model was applied. Three cases of global model above have different vertical 

displacements in the girder. The vertical displacements in the girder that is result the 

shape of girder were applied as a load to the submodel. Stresses in the web gap area 

and in the bottom flanges of the girder are used on this comparison. When truck stop 

at 10 m from the edge, the comparison results for all cases are shown in table 4.3. 

Table 4.3 Comparison stress in the bottom flanges in the mid-span between global model, submodel, and field test 

Case 
Girder Field test Global model Submodel Difference to Field

(MPa) (Mpa) (Mpa) (%) 

a 
G1 24.2 23.9 23.7 2 
G2 14.4 12.3 11.29 20 
G3 3.8 1.6 0.8 78 

b 
G1 6 3.1 2.4 15 
G2 14.4 13.3 12.2 7 
G3 22.6 23.1 24.2 6 

c 
G1 27.2 25.5 25.48 6 
G2 27 25.1 22.7 15 
G3 29 25.1 25.6 11 

case (a) = one truck on left lane, case (b) = one truck on right lane c, and case (c) = 

two trucks on both lanes. 

 

The comparison shows that the maximum stresses that occurred in the girder 

close to the truck wheel position. In case (a) and case (b), the exterior girder in 

unloading lane shows very small longitudinal stress in the bottom flanges. In case of 

two trucks on both lanes, case (c), all girders share approximately the same stresses. 

The comparisons also show a reasonable agreement between the submodel, global 

model and the field test data of longitudinal stress in the mid-span bottom flange of 

the girders. 

4.2.3.3 Web Gap Stress 

The finite element study is used to investigate the maximum stress at the web 

gap. After an examination of the web gap stress data, stress data of strain gage in the 

girder G1 when truck is in the left lane and stops at 10 m from the support. A stress 

value of 13.2 MPa was decided as a benchmark experimental value in comparing with 

the finite element results.  

The finite element model predicted a maximum web gab stress (at the end of 

stiffener) of about 44.7 MPa. It is much higher than 13.2 MPa from field test data. It 

can be attributed to the position of the strain gage and the web-gap deformation 
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mechanism. Stress distribution along the girder length of the web gap is plotted in 

figure 4.37. The 34 mm position indicates the stress along the web-to-bottom-flange 

junction and the 0.0 mm position means the stress at the end of stiffener. 
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Figure 4.37 Distribution of web gap stress along the girder length 

Figure 4.37 shows the stress changes in the horizontal section. It means that 

the stress field around the connection between girder web and stiffener changes 

quickly, even small differences in strain gage placement can give large variations in 

strain readings (Jajich et al, 2000)  

Because of the installation difficulties in the real bridge, the strain gage 

placement was modified as shown in figure 4.38. 

 

 

 

      

 

 

 

 

Figure 4.38 Strain gage placement 
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When the actual strain gage position is overlaid on the finite element stress 

distribution, as shown in figure 4.39, the finite element model predicted the stress to 

be 9.3 MPa at the strain gage location. Measured web gap strain shows 66 με, means 

the stress is 13.2 MPa. Therefore, the finite element result underestimates the field test 

result by 30%, but the quick stress gradient, the human error, and also the possibility 

of gage error also needs consideration (Jajich et al. 2000) 
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Figure 4.39 Comparison between measured web gap stress and prediction from 

results 

 

Another important issue is the web gap deformation. It guides to the stress in 

the top of web gap. The deformation shape was shown in figure 4.40. It shows the 

double curvature shape of web gap because the rotation and the horizontal occurred in 

both end of web gap. 
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Figure 4.40 Web gap deformed shape 

 

The finite element model showed the nodal rotation and displacement of web 

gap as shown in Figure 4.41. Assume the force is applied to the web gap only from 

the diaphragm rotation, if the vertical displacement is neglected, the direct stiffness 

method can be used to get the moment in the top of web gap. 

 

 

 

 

 

 

 

 

 

 

Figure 4.41 Displacement of web gap 

Using the simple equilibrium equation of the beam, the moment in the top of 

web-gap can be obtained. 
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Assume the web gap to be applied by M2 moment only. With L = web gap length (35 

mm), E = 20000 MPa, thus: 

4322122

2646 
L

EI

L

EI

L

EI

L

EI
M 


  (4.3)

NmmM 689796.72   

Assume y= half of girder web thickness, thus stress in the web gap: 

I

My
  (4.4)

MPa14.46  

 

Refer to figure 4.39, the calculation above gives underestimates the measured 

strain in the web gap within 2 %. This simple calculation asumess that the web gap 

undergo rotation and horizontal translation at both ends of web gap. 

Distortion-induced stress is influenced by relative displacement between 

adjacent girders (Fisher et al. 1990). The increasing of relative displacement will 

generate the higher distortion induced stress.  

The calibration and examination in the web gap area with many cases shows 

that the assumptions and the methods used in finite element model are appropriate to 

represent the behavior of the real bridge. In other words, the finite element model can 

be used in the parameter study. 

 

 



CHAPTER V 

 

PARAMETRIC STUDY 

 
 
5.1 Overview  

The objective of this parametric study is to investigate the influence of the 

bridge parameters on the relative girder deflections and maximum web gap stress. 

Dual level analysis was used in parametric study. Both global model and submodel 

were modeled using software package SAP2000. Parametric study was done by 

varying one parameter and fixing the other parameter. AASHTO standard truck HS20 

was applied in multistep analysis. The truck was modeled to move in the line with a 

certain speed and stop in a certain time. Multistep analysis in global model results the 

maximum relative differential between adjacent girders. The girder’s deformation 

shape was applied as loading to the submodel. Maximum relative displacement in the 

global model and the maximum tension web gap stress is studied.  

 

5.2 Description on Finite Element Model 

Both global model and submodel were made based on the finite element mesh 

in chapter III with some modifications. The global model consists of concrete slab, 

three main girders, and diaphragms at midspan, quarter spans and end spans of the 

bridge. This parametric study assumes a fully composite action. Thus, rigid links with 

all degree of freedom between the shell elements and frame elements coupled. The 

superstructure had two lanes with no sidewalk and the lanes width is as the same as 

girder spacing. Similarly, submodel portion, boundary and mesh of the submodel 

were made based on the finite element study in chapter III. A total 56 of Global model 

and submodel with 234 cases were analyzed in this study. 
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5.3 Bridge Parameters 

The parameters chosen in the study are the bridge length (L), girder spacing 

(S), slab thickness (ts), and girder stiffness (Ig). These parameters are shown in figure 

5.1. 

 

Figure 5.2-1 Parameters in parametric study 

 

 

 

 

 

 

Figure 5.1 Typical FEM with base bridge parameter 

 The range of parameters was based on the applicability range in the AASHTO 

LDF equation. For example, the bridge length (L) varied from 18 m to 36 m, girder 

spacing (S) varied from 2.1 m to 3.0 m, and slab thickness (ts) varied 210 mm to 300 

mm. The range of girder stiffness (Ig) was based on the real bridge design. It varied 

from 1.11010 mm4 to 1.71010 mm4. To study the effect of a specific parameter, 

other parameters are fixed in the finite element analysis. The basic parameter values 

are as follows: bridge length = 24 m, girder spacing = 3.0 m, slab thickness = 240 

mm, girder frame is I section 14504501222 with inertia stiffness = 12.9109 

mm4 and diaphragm I section 6782531216 with inertia stiffness = 1.6109 mm4. 

Sixteen variations were modeled in the parametric study. All of the bridge parameters 

are shown in table 5.1.  

 

 

 

 

 

 

 

 

 

Ig = 1.29x10
10 mm4 

L = 24 m 

S = 3 m 

ts= 240 mm 
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 Table 5.1 Bridge’s finite element model parameter  

Girder spacing 

(m) 

Slab Thickness 

(mm) 

Girder stiffness 

(mm4) 

Bridge length 

(m) 

2.1 240 1.2 × 1010 24 

2.4 240 1.2 × 1010 24 

2.7 240 1.2 × 1010 24 

3.0 240 1.2 × 1010 24 

3.0 210 1.2 × 1010 24 

3.0 240 1.2 × 1010 24 

3.0 270 1.2 × 1010 24 

3.0 300 1.2 × 1010 24 

3.0 240 1.0 × 1010 24 

3.0 240 1.2 × 1010 24 

3.0 240 1.5 × 1010 24 

3.0 240 1.7 × 1010 24 

3.0 240 1.2 × 1010 18 

3.0 240 1.2 × 1010 24 

3.0 240 1.2 × 1010 30 

3.0 240 1.2 × 1010 36 

 

5.4 Truck Loading 

AASHTO HS20-44 standard truck was used in the parametric study. The truck 

load configuration is shown in figure 5.2. Two general types of loading are one truck 

on left lane and two trucks on both lanes.  

 

 

 

 

 
 
 
 

 Figure 5.2 AASHTO truck configuration (HS20-44)  
 
 

3.63 T 14.52 T 14.52 T 

4.27 m V 

V = variable spacing (4.27 m until 9.15 m) 
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Figure 5.3 shows the possible combinations for two trucks on both lanes. The 

outer-outer loading combination is when one truck moved in the left edge of left lane 

and another truck on right edge of right lane, as shown in Figure 5.3 (a), center-center 

loading combination is when both trucks moved in the center of the left and right 

lanes, as shown in Figure 5.3 (b), and inner-inner loading combination is when one 

truck moved in the right edge of left lane and another truck on left edge of the right 

lane, as shown in Figure 5.3 (c). Other transverse loading combinations include the 

outer-center, outer-inner, and center-inner are shown in Figure 5.3 (d), (e), and (f), 

respectively.  

 

 

 

 (a)  (b)  (c) 

 

 

 

(d)  (e)  (f) 

Figure 5.3 Transverse loading combination (a) Outer-outer (b) Center-center (c) 
Inner-inner (d) Outer-center (e) Outer-inner (f) Center-inner 

 

5.5 Discussion on Finite Element Model Result 

5.5.1 Critical Longitudinal and Transverse Positions of Truck Loading  

In this parametric study, the truck was modeled to move along the bridge with 

speed 1 mm/s and to stop in every 100 second. It means the data from the truck load 

was collected in every 0.1 m. The first wheel of the truck was read by SAP2000 at the 

pivot point or the position of the truck load based on the first wheel. After examining 

the vertical displacement data, truck loading around midspan (first wheel 17.9 m from 

the support) causes the highest relative displacement between adjacent girders. It is 

also found in bridge length 18 m, 30 m, and 36 m that the maximum relative 

displacement occurs when truck around midspan. The same results were observed 

from both general types of loading.  

G1 G2 G3G1  G2 G3  G1  G2 G3

G1  G2 G3  G1 G2 G3 G1  G2 G3
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In the two truck cases, the variations of transverse position were also 

combined. The examination shows the O-I (outer-inner) configuration, as shown in 

figure 5.3 (e). It results in the highest maximum relative displacement between 

adjacent girders rather than other transverse configuration. One of the trucks is on the 

outer lane above girder G1 and G2 and the other one is on the inner lane above girder 

G2 and G3. Both trucks move together along the bridge.  

 

5.5.2 Maximum Relative Displacement Between Adjacent Girders (Global 

model) 

5.5.2.1 Effect of Girder Spacing 
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  (a) (b) 
Figure 5.4 Girder spacing effect (a) One truck on left lane (b) Two trucks on both 

lanes 

Figure 5.4 shows that the maximum relative deflections between adjacent 

girders as a function of the girder spacing. As the girder spacing increases, the length 

of diaphragm increases, thus, reducing the diaphragm stiffness and resulting to the 

increase of relative deflection. For the case of one truck loading, the difference 

between relative displacements between girders under loaded lane and unloaded lane 

is insignificant, as shown in figure 5.4 (a). The maximum relative deflection occurs 

when the truck is on the left end of the left lane (outer of the lane). Similar trend was 

also found in the case of two trucks, as shown in figure 5.4 (b), and the critical 

transverse truck combination is outer-inner. The maximum vertical deflection is in the 

girder G1, followed by girders G2 and G3, with relative displacement between G2 

and G3 higher. Maximum relative displacement between adjacent girders for one 

truck loading is more critical than two trucks loading. 

G1  G2  G3 
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5.5.2.2 Effect of Slab Thickness 
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(a)  (b)  

Figure 5.5 Slab thickness effect (a) One truck on left lane (b) Two trucks on both 

lanes 

As shown in figure 5.5, the relative deflection decreases as slab thickness 

increases and comparison of both cases shows one truck case is more critical than two 

truck case. Figure 5.5 (a) shows the similarity relative displacement between girder 

under loading and unloading lane. Both show decreasing trend. Increasing the slab 

thickness causes the slab become more rigid and the unity of the slab become higher. 

It means that when the slab is very thick, live load in every position will cause the 

entire slab to deflect together as a unit. Moreover, slab thickness will transfer 

homogeny to all girders and relative deflections between girders will become equal. 

Figure 5.5 (b) shows the similar results for the case of two trucks. The critical 

transverse position in two truck case is outer-inner.  

5.5.2.3 Effect of Girder Stiffness 

Girder is the main element of the bridge as it provides the longitudinal stiffness 

to the whole superstructure. If all girders are very stiff, the relative deflection between 

adjacent girders will be small, as shown in the trend in figure 5.6. In case of one truck 

loading, figure 5.6(a) shows that the relative deflection decreases as the girder 

becomes stiffer. For the two trucks loading, figure 5.6(b) shows that the outer-inner 

combination is a critical combination and the trend observed is similar to the case of 

one truck. The relative displacement of girder G2 and G3 is higher than G1 and G2. 

One truck case results higher critical relative displacement between adjacent girders 

than two truck case. 

G1  G2  G3 
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(a)  (b)  

Figure 5.6 Girder stiffness effect (a) One truck on left lane (b) Two trucks on both 

lanes 

5.5.2.4 Effect of Bridge Length 
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(a)   (b)  
Figure 5.7 Bridge length effect (a) One truck on left lane (b) Two trucks on both 

lanes 

Figure 5.7 shows the maximum relative deflections between adjacent girders 

as a function of the bridge length. The results show that the relative girder deflection 

becomes higher when the bridge length increases. Figure 5.7 (a) shows the results for 

the case of one truck on left lane. At a specific bridge length, the maximum value 

between the girders G1 and G2 is almost similar to the girders G2 and G3. Figure 5.7 

(b) shows the results for the maximum relative deflection in case of two trucks and 

the outer-inner combination. In the case of two trucks, the relative displacement 

between G2 and G3 is higher than G1 and G2. For the case of two trucks, the 

maximum relative deflection was lower than the case of one truck.  

G1  G2  G3 

G1  G2  G3 



67 
 

5.5.3 Maximum Web Gap Stress 

Figure 5.8 shows the transverse section of the bridge with determined web gap 

sides. After vertical displacement was applied in the submodel, midspan transverse 

section’s deformed shape of finite element model with 3m girder spacing was shown 

in figure 5.9 and figure 5.10 for one truck case and two truck case, respectively. 

 

Figure 5.8 Web gap sides 

 

Figure 5.9 Midspan transverse section deformation shape in case of one truck loading 

 

Figure 5.10 Midspan transverse section deformation shape in case of two truck 

loading 

G1  G2 G3 

G1R G2R G3RG1L G2L G3L 

G1 

G2

G3 

G1  G2
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Using the refined finite element model, the peak web gap stress can be 

investigated. Figure 5.11 and figure 5.12 shows the vertical stress contour in the web 

gap area in the midspan of girder G1 and G2 in one truck case, respectively. It shows 

the stress field decays rapidly in both longitudinal and vertical directions away from 

end of stiffener. Stress distribution in the web gap area for all submodel shows the 

critical vertical stress occur in the top of web gap at the end of stiffener as shown in 

figure 5.13.   

 

   

(a) (b) 

Figure 5.11 Stress distributions in web gap area of girder G1 (a) 3D view (b) Girder 

web view 

  

(a) (b) 

Figure 5.12 Stress distributions in web gap area of girder G2 (a) 3D view (b) Girder 

web view 
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Figure 5.13 Critical vertical web gap stress position 

5.5.3.1 Effect of Girder Spacing 
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(b) 

Figure 5.14 End of stiffener stress (a) One truck case (b) Two trucks case 
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(b) 

Figure 5.15 Near bottom flange stress (a) One truck case (b) Two trucks case 

G1  G2  G3 

Critical web gap stress position 
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(b) 

Figure 5.16 Girder spacing affect (a) One truck case (b) Two trucks case 

Figure 5.14 shows the maximum web-gap stress as a function of the girder 

spacing in the end of stiffener and Figure 5.15 shows the maximum web-gap stress 

near bottom flanges. As shown in these figure, the critical web gap stress occurred in 

the end of stiffener of G2 in case of one truck and two truck case results the critical 

web gap stress in the area near bottom flanges. This result was obtained in all case of 

parameter. The critical web gap stress was shown in figure 5.16. All of the web-gap 

stresses occurred in the right side because girder G1 deflected the most. It was 

followed by girder G2 and G3, which shows that the tension area is in the right side of 

the web gap. In the case of one truck, the maximum web-gap stress occurred at the 

end of right stiffener of girder G2 (G2R side). Figure 5.16(a) shows that the maximum 

web gap stress does not change as the girder spacing increases. In the case of one 

truck, the rotation of diaphragm of every girders spacing, which was identified in 

dividing the relative displacement by the girder spacing, is almost equal. It result the 

critical web gap stress getting identical in every girder increasing. This assumption is 

accordance with Jajich et al.(2000) which is determined the web-gap stress by using 

the rotation of diaphragm. In two trucks loading, the maximum web-gap stress is 

higher as the girder spacing increasing and this is demonstrated in figure 5.16(b). The 

maximum web gap stress in the G2R and G3R is higher than G1R because the relative 

displacement between girder G2 and G3 is higher than between girder G1 and G2. 

Similar with relative displacement, comparison between two case shows one truck 

case result more critical vertical web gap stress in the end of stiffener than two truck 

case.  

G1  G2  G3 
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5.5.3.2 Effect of Slab Thickness 
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(a) (b) 
Figure 5.17 Slab thickness effect (a) One truck case (b) Two trucks case  

As shown in figure 5.17, the maximum web gap stress decreases as slab 

thickness increases. Figure 5.17 (a) shows the results from one truck when the truck 

moves on the left edge of the left lane. It shows the maximum web-gap occurs in the 

G2R. Figure 5.17 (b) shows the similar results for the case of two trucks. The critical 

transverse position is the outer-inner combination. The relative displacement when the 

two trucks moves between girder G2 and G3, and it is higher than between G1 and 

G2. It causes the web-gap stress in the G2R and G3R identical and higher than G1R 

maximum web-gap stress. Comparison between two cases shows critical vertical web 

gap stress in the end of stiffener in one truck case is more critical than two truck case. 

It appropriates to the relative displacement comparison. 

5.5.3.3 Effect of Girder Stiffness 
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(b) 

Figure 5.18 Girder stiffness effect (a) One truck on case (b) Two trucks case  
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If all girders are very stiff, the relative deflection between adjacent girders will 

be very small and the maximum web-gap stress reduces in both sides. Figure 5.18(a) 

shows that the relative deflection decreases as the girder becomes stiffer. The 

maximum web-gap stress occurs in the end of stiffener of G2R side and follow by 

G1R and G3R. Figure 5.18(b) shows the results for the case of two trucks and the 

outer-inner combination, which is a critical combination. The trend is similar to the 

case of one truck. In this parametric study, girder web and flanges were made thicker 

every increasing of girder stiffness. It cause web gap area become more stiff and 

result web gap stress decrease in girder stiffness increasing. Maximum web gap stress 

in the G2R and G3R is almost same and G1R result lower web-gap stress. It can be 

occur because of the differences of relative displacement. Similar with relative 

displacement comparison, one truck case shows more critical result than two truck 

case. 

5.5.3.4 Effect of Bridge Length 
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(b) 

Figure 5.19 Bridge length effect (a) One truck case (b) Two trucks case 

Figure 5.19 shows the maximum web gap stress as a function of the bridge 

length. The results show that the web-gap stress becomes higher as the bridge length 

increases. Figure 5.19 (a) shows the results for the case of one truck on left lane. At a 

specific bridge length, the maximum web gap stress in G2R and G1R is almost 

similar, and both are higher than G3R. Figure 5.19(b) shows the results for the 

maximum relative deflection in case of two trucks and the outer-inner combination. In 

case of two trucks, the relative displacement between G2 and G3 is higher than G1 

G1  G2  G3 
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and G2, but the finite element model (submodel) shows the critical web-gap stress to 

occur in the G2R, G1R and G3R consecutively. It contradicts with the relative 

displacement result where the relative displacement between G2 and G3 is higher than 

between G1 and G2. This happened probably because the relative displacement is 

very high and it led the stress in the stiffener side (inside side) to be higher than the 

outer side of external girder. Overall case of two trucks shows the maximum relative 

deflection to be lower than the case of one truck.  

5.5.4 Lateral Load Distribution Factor 

Another important issue of bridge design is lateral load distribution factor. It 

shows the maximum moment and shear of each girder because of the live load in 

concrete slab. Distribution factor was calculated by applying the finite element model 

with the truck positioned at the longitudinal location to produce the maximum 

moment. The trucks were then moved transversely across the width of the girder until 

it resulted to the largest moment in the girder section. The ratio of this moment to the 

moment from simple beam loading with one truck wheel line represents the 

distribution factor as demonstrated by Mabsout et al (1998) and Zokaie et al (2000). 

In this study, the lane was assumed as the same as girder spacing and applied by one 

truck each lane. Truck does not move to the other lane. 

5.5.4.1 SAP2000 Result  

The SAP2000 beam result are illustrate in figure 5.20. In this figure, P is the 

axial forces, M2 and M3 are the bending moments about the local axes 2 and local 

axes 3. The local tangent along the beam element, local axis 1, is defined as a vector 

from the node i to j. The local axis 3 direction is perpendicular to the local axes 1 and 

the local axes 2. These three axes follow the right-hand-rule. The result from the beam 

element that used in the load distribution factor analysis is P and M33. 

The shells result was obtained using section cut ability in SAP2000. Section cut 

results of shell are illustrate in figure 5.21. The result from the section cut that used in 

the load distribution factor analysis is F2 and M2. 
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Figure 5.20 Notation of beam element result 

 

 

 

 

 

Figure 5.21 Notation of section cut result 

 

5.5.4.2 Effective Width 

The section cut length was built base on the effective width of the deck. The 

effective width of the deck was recommended by AISC. The effective width of slab is 

distance a plus distance b, as shown in figure 5.22. Value of a and b is the smallest 

value of:  

 One-eighth of the effective span length; 

 Half of spacing of adjacent beams. 

 The width of the overhang. 

 

 

 

 

 

 

 

 

Figure 5.22 Effective width 
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5.5.4.3 Moment in The Girder Section 

In order to calculate the load distribution factor from the finite element model, 

the moment in the girder section has to be determined. The moment in the girder 

section is the resultant of girder moment in the beam element, deck moment in the 

shell element, and moment from the axial forces, as shown in figure 5.23.  

 

 

 

 

 

 

 

 

 

 

 

Figure 5.23 Notation of section cut result 

a) Girder moment 

The girder moment is the moment in the beam element. The girder moment in 

the midspan is obtained from the output of SAP2000. Moment M3 of the frame 

element is the longitudinal moment output. 

element) (frame M3gM   (5.2)

b) Deck moment 

The deck moment is the moment in shell element. It is generated by the 

section cut in SAP2000, as shown in figure 5.24. Moment in axes 1 was determined as   

deck moment. moment is the moment in the beam element. The girder moment in the 

midspan is obtained from the output of SAP2000. Moment M3 of the frame element 

is the longitudinal moment output. 

)( M1 cut sectionM s    (5.3)
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Figure 5.24 Section cut form in SAP2000 

c) Moment produced by axial force 

After the force and moment in the girder are known, the neutral axis of the 

girder can be determined. The neutral axis is where the strain and the corresponding 

stress in the beam element are zero. The eccentricity from the neutral axis to the 

centroid of the girder is calculated as follows:  

 

gg

gg
g MA

IF
e




  

 
(5.4)

and 

gs eee    (5.5)

Then the moment due to the axial force can be calculated as follows: 

ssggaxial eFeFM    (5.6)

Where Ag and Ig are the girder area and moment inertia, respectively, Fg is the girder 

axial force, Fs is the integrated axial force in the shell element, e is the distance 

between the centroids of the girder and the deck, eg and es are the eccentricity from 

the section’s neutral axis to the centroids of the girder and the deck, and Maxial is the 

moment from the axial force. 
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5.5.4.4 Moment From Beam Analysis 

In this study, a simple beam model was constructed. To accommodate the finite 

element model in parametric study, four simple beam models with different length 

was constructed. The length is 18 m, 24 m, 30 m, and 36 m. The length and the mesh 

of the beam is the same as the three dimension finite element model. The loading is 

one lane of wheel loads move along the length of the beam. This was modeled in 

SAP2000 as shown in figure 5.25.  

 

Figure 5.25 One lane wheel load in SAP2000 

Simple beam analysis results showed that the maximum moment occurred in the 

mid-span area when the first wheel of truck is 16.4 m from edge of the 24 m beam. 

One line wheel truck on 13.4 m, 19.4 m, and 22.4 m caused the maximum moment for 

18 m, 30 m, and 36 m beam length, respectively. Beam 18 m has the maximum 

moment 5.4×108 N-mm. Beam 24 m has the maximum moment 7.86×108 N-mm. The  

30 m beam result the maximum moment 1.03×109 N-mm. Maximum moment 

1.28×109 N-mm occurred in 36 m beam. 

5.5.4.5 LDF Calculation 

 In the calculation of the load distribution factor, moment in the girder section 

from the finite element model results and the maximum moment from one 

dimensional beam analysis were compared. The moment in the girder section from 
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the finite element analysis is composed by girder moment, deck moment, and moment 

from the axial force.  

One truck in left case and two trucks on both lanes case were analyzed using the 

finite element model. Each lane was divided in transverse direction into three in order 

to get the maximum moment with the same longitudinal position of truck. For one 

truck case, the maximum moment occurred when the truck move in the outer lane. 

The outer-inner combination of truck shows the maximum moment result in case of 

two trucks. The LDF is determined using the moment in the girder section divided by 

the maximum moment from the one-dimensional beam analysis. The load distribution 

factors of external girder for every model are shown in figure 5.26 until figure 5.29. 
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(a) (b) 
Figure 5.26 Girder spacing effect (a) One truck on left lane (b) Two trucks on both 

lanes 
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(a) (b) 
Figure 5.27 Slab thickness effect (a) One truck case (b) Two trucks case 
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(a) (b) 
Figure 5.28 Girder stiffness effect (a) One truck case (b) Two trucks case 
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(a) (b) 
Figure 5.29 Bridge length effect (a) One truck case (b) Two trucks case 

 

Four key parameter of lateral load distribution was investigated in the 

parametric study. The parameters are girder spacing (S), slab thickness (ts), girder 

stiffness (Ig), and bridge length (L). Figure 5.26 to figure 5.29 shows the effect of each 

parameter on the distribution factor using the global model. The distribution factors 

decreases as the girder spacing and girder stiffness increase. This observation was 

also demonstrated in figure 5.26 and figure 5.28, respectively. However, the 

distribution factor increases as the slab thickness and bridge span increases. It can be 

verified by referring to figure 5.27 and figure 5.29, respectively. This result is in 

accordance with Zokaie’s study. 

 



80 
 

5.6 Comparison Between AASHTO and Thai Trucks 

5.6.1 Lateral Load Distribution Factor 

Two different trucks, AASHTO truck and Thai truck, were evaluated using the 

finite element model. The properties of both trucks are shown in figure 5.30. For 

comparative purpose, a base finite element model from parametric study was used. 

The finite element model was evaluated with one truck and two truck case and load 

distribution in external girder was compared. 

 

 

 

 
 
 
 

  
(a)  

 
 
 
 
 
 
 
 
 

(b) 

Figure 5.30 Characteristic of truck (a) AASHTO truck (b) Thai truck 
 

Simple beam model was constructed in order to obtain the maximum moment 

by both AASHTO truck and Thai truck load. Simple beam model was constructed 

according the length of base finite element model, which is 24 m. The mesh of beam 

was made according the girder in global model. In a one dimension analysis, the truck 

load was modeled as one wheel load. The configuration of one lane vehicle load from 

SAP2000 is shown in figure 5.31. Simple beam analysis showed that the maximum 

moments occurred in the mid-span area when the first wheel of truck is 16.4 m from 

edge for AASHTO truck, and 16.3 m for Thai truck loading. One lane wheel of 

6.2 T 12.6 T 12.6 T 

4.27 m 1.3 m 

4.27 m V 

3.63 T 14.52 T 14.52 T 

V = variable spacing (from 4.27 m to 9.15 m) 
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AASHTO truck had a maximum moment 7.9×108 Nmm and Thai truck’s one lane 

loading had a maximum moment 8.4×108 Nmm.  

 

(a) 

 

(b) 

Figure 5.31 Characteristic of truck loadings in SAP2000 (a) AASHTO truck (b) Thai 
truck 
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The truck longitudinal position obtained from simple beam model was used 

with varying transverse position. According to the previous sub-chapter the critical 

transverse position is when truck move in the outer lane for one truck case and one 

truck in the outer lane plus one truck in the inner lane is the the critical transverse 

position for two trucks case 

The maximum moment occurred in G1 because it is below the truck lane. The 

controlling moment was then selected. Similar method with chapter 5.5.4 was used to 

obtain the longitudinal moment in the composite bridge as shown in figure 5.21.The 

load distribution factor of external girder in one truck case results 1.14 for AASHTO 

truck and 1.11 for Thai truck, while two AASHTO truck and Thai truck result 1.54 

and 1.44 load distribution factor, respectively. 

The distribution factor from AASHTO truck was overestimated the Thai truck. 

However, the difference is only 10% and can be neglected. This is as the same as 

Chaisombob and Larshima (2000) study, which is a result of Thai truck distribution 

factor, it is smaller than the distribution factor from the AASHTO HS20-44 trucks. 

 

5.6.2 Web Gap Stress 

In order to obtain the maximum web-gap stress with the same bridge 

dimension, the maximum relative displacement between adjacent girders must be 

predicted. The truck on the outer lane of left lane was chosen on this analysis because 

it results the critical maximum relative displacement in the midspan. From the global 

model AASHTO truck in 17.9 m and Thai truck in 16.2 m longitudinal position, the 

maximum relative displacement for both truck cases is 4.1 mm for one truck in the 

outer lane that is occurred in the girder under loading and unloading lane. Afterward, 

2.6 mm relative displacement under the truck in move in the inner lane was occurred 

in two truck case. The girder shape of all three girders from quarter-span until three-

quarter span was applied from the load to the submodel. After the deformed shape of 

girder was applied to the submodel, SAP2000 analysis shows that the maximum web 

gap stress occurred in the end of stiffener for the two types of truck load. Maximum 

web gap stress in every girder was obtained from G1R, G2R, and G3R where the 

tension stress occurred. All maximum web gap results are shown in figure 5.32. 
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Figure 5.32 End of stiffener vertical web gap stress in each girder (a) One truck case 
(b) Two truck case 

 
Figure 5.32 shows the web gap stresses at the end of stiffener of every girder. 

It shows that the critical web gap stress occurred in the G2R area in case of one truck 

and G3R area in case of two trucks. Figure 5.32 shows the maximum web-gap stress 

of AASHTO truck loading to be slightly an overestimate of the Thai truck loading. 

The difference critical web gap stress of two truck loading types is 1% for one truck 

case and 2% for two truck case, which occurred in G1R and can be neglected. 



CHAPTER VI 

 

DEVELOPMENT OF THE FORMULA FOR RELATIVE 

DISPLACEMENT BETWEEN ADJACENT GIRDER AND WEB GAP 

STRESSES 

 
6.1 Ranking of The Influencing Bridge Parameters  

Chapter 5.5 explains the study on the effect of the bridge’s parameters on the 

relative displacement and web gap stress. The most influenced parameter yields the 

highest deviation of result in the same increasing. However, the units of these 

parameters cause a problem in determining the most influential parameter. In order to 

eliminate the parameter’s unit, the increasing from the smaller value of the parameters 

(%) needs to be used. Increasing parameters means the different of the next parameter 

to the first parameter divide by the first parameter and multiplied by 100%. The 

dependent value (relative displacement between adjacent girder of or maximum web-

gap stress) was modified to the deviation to the first parameter. In other words, the 

smallest value of each parameter increasing should be equal to zero and the next 

parameter as the increasing of the second, third, and fourth value in percent.  

6.1.1 Relative Displacement Between Adjacent Girders. 

The effect of the parameter increasing on the deviation relative displacement 

between adjacent girders is shown in figure 6.1 until figure 6.4.  
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  (a) (b) 
Figure 6.1 Girder spacing effect (a) One truck case (b) Two trucks case 
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3 Increasing of slab thickness (%) 
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(a) (b) 

Figure 6.2 Slab thickness effect (a) One truck case (b) Two trucks case 
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(a) (b) 

Figure 6.3 Girder stiffness effect (a) One truck case (b) Two trucks case 
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(a)   (b)  
Figure 6.4 Bridge length effect (a) One truck on case (b) Two trucks case 
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Figure 6.1 until figure 6.4 plot the deviation of critical relative displacement 

between adjacent girders with increasing of parameter. Positive slope means the 

relative displacement gets higher with increasing bridge parameter and vice versa. 

Figure 6.1 (a) shows the regression line slope for a one case truck to be lower than 

two truck case, as shown in figure 6.1(b). It means the range of the relative 

displacement of two truck cases is higher than a one truck case. From figure 6.1 to 

figure 6.4, a one truck case slope of linear regression shows that the highest slope 

occurred in comparison of bridge length parameter then followed by slab thickness, 

girder spacing, and the lowest slope as the girder stiffness comparison. For 

comparison, in 40% increasing of bridge length result 3 mm deviation of relative 

displacement, slab thickness result 1.3 mm, girder spacing result 1.2 mm, and when 

girder stiffness increasing 40%, the relative displacement decrease 0.8 mm. It shows 

the sensitivity rank of parameter to the relative displacement between adjacent girders 

in one truck case is bridge length, slab thickness, girder spacing, and girder stiffness. 

Similarly for the two truck case, the highest slope occurs in bridge length, but in this 

case followed by girder spacing, slab thickness, and girder stiffness. For comparison, 

40% increasing of bridge length, girder spacing, slab thickness, and girder stiffness 

result 1.8 mm, 1.6 mm, 0.9 mm, and 0.5 mm deviation of relative displacement, 

respectively. Overall the most influential bridge parameter to the relative 

displacement between adjacent girders is the bridge length, while the smallest 

influence was observed from the girder stiffness. 

6.1.2 Web Gap Stress. 

The effect of each parameter increasing in maximum web gap stress is shown 

in figure 6.5 until figure 6.8.  
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   (a) (b) 

Figure 6.5 Girder spacing effect (a) One truck case (b) Two trucks case 

Increasing of slab thickness (%) 
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(a) (b) 

Figure 6.6 Slab thickness effect (a) One truck case (b) Two trucks case 
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(a) (b) 

Figure 6.7 Girder stiffness effect (a) One truck case (b) Two trucks case 
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(a) (b) 

Figure 6.8 Bridge length effect (a) One truck case (b) Two trucks case 

Figure 6.5 until figure 6.8 shows the quadratic polynomial regression of 

relative displacement between adjacent girders and bridge parameter comparison. 

Similar sensitivity analysis method is also adopted in the web gap stress comparison. 

The difference of critical web gap stress in case of one truck from figure 6.5 until 

figure 6.8 shows that the highest difference occurred in comparison of girder stiffness 

parameter. It is then followed by bridge length, slab thickness, and the lowest slope is 

occur comparison girder spacing. Girder stiffness can be give more influence than the 

girder spacing because the variation of girder stiffness was done with varying 

thickness of girder flanges and web. Comparison between influences of girder spacing 

and slab thickness were determined by the influence of these parameters in relative 

displacement as the relative displacement also governs the maximum web gap stress 

(Fisher et al (1990). In relative displacement, slab thickness is more influence than 

girder spacing in one truck on left case but in case of two trucks, girder spacing has 

more influence than slab thickness. In case of two trucks, the two most influential 

parameters is bridge length then followed by girder stiffness, girder spacing, and slab 

thickness.  

6.1.3 Lateral Load Distribution Factor. 

The effect of each parameter increasing in deviance of lateral load distribution 

factor is shown in figure 6.9 until figure 6.12.  
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   (a) (b) 

Figure 6.9 Girder spacing effect (a) One truck case (b) Two trucks case 
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(a) (b) 

Figure 6.10 Slab thickness effect (a) One truck case (b) Two trucks case 
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(a) (b) 

Figure 6.11 Girder stiffness effect (a) One truck case (b) Two trucks case 
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Increasing bridge length (%)
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(a) (b) 

Figure 6.12 Bridge length effect (a) One truck case (b) Two trucks case 

Figure 6.9 until figure 6.12 shows the regression of lateral distribution factor 

difference and bridge parameter increasing comparison. Similar sensitivity analysis 

method is also adopted in the web gap stress comparison. In case of one truck, with 

40% increasing of girder spacing, bridge length, slab thickness, and girder stiffness 

result the difference 0.2, 0.08, 0.07, and 0.03, respectively and 0.2, 0.04, 0.04, and 

0.01 deviation in case of two truck, respectively. It shows the girder spacing have the 

most influence  then follow by bridge length, slab thickness, and girder spacing for 

both case. 

6.2 Development of Formula 

All the comparison of bridge parameters with relative displacement between 

adjacent girders and maximum web gap stress shows the bridge parameter effect to be 

linear. It can lead to the formulation based on this linear regression from each 

parameter effect. Subsequently, all the parameter formulas are combined by multiple 

linear regression to generate the formulation of maximum relative displacement.  

Assuming that the effect of each key parameter can be modeled by functions 

f(L), f(S), f(ts), and f(Ig), respectively, the equation of bridge parameter effect can be 

expressed in the form of: 

  LItSY gsi 43210  (6.1)
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The model can be rewritten as  

11413121101   LItSY gs  

22423222102   LItSY gs  

 

nnngnsnn LItSY   43210  

(6.2)

In the parametric study, 16 finite element models were constructed with 

varying bridge parameters. Bridge length (m), girder spacing (m), and slab thickness 

(mm) varied in the parametric study. Girder stiffness is converted to m4 to avoid the 

singular matrix. In matrix terms, the independent variable is: 
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X  

(6.3)

 

The dependent variable in this study is the result of the parametric study. This 

parametric study showed that the maximum relative displacement between adjacent 

girders in case of one truck on left and two trucks on both lanes and maximum web 

gap stress in both cases. The dependent variable for maximum relative displacement 

between adjacent girders in case of one truck is the relative displacement under 

loading lane is: 
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(6.4)

 

Dependent variable of maximum relative displacement between adjacent girders in 

two trucks case is the relative displacement under truck in the inner side of the lane: 
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(6.5)

 

mm 
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Dependent variable of maximum web gap stress in one truck case is the critical 

vertical stress: 
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                                                           (6.7)

Dependent variable of maximum web gap stress in two trucks case is the vertical 

stress in the end of stiffener in G3R side: 
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(6.7)

 

β is determined based on the variation of these parameters distribution. Multiple linear 

regression analysis results use X and Y matrix to get β value. 

MPa 

MPa 
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  YXXXβ T1T 
  (6.8)

The equation gives the coefficient β of Y equation. The formulas obtained from the 

multiple linear regressions are listed below. 

Relative displacement between adjacent girders for one truck loading 

LItS gsT 47.005.17856.1449.187.51  (6.9)

with R2 value is 0.98 

Relative displacement between adjacent girders for two trucks loading 

LItS gsT 27.069.10237.994.104.62  (6.10)

with R2 value is 0.98 

Maximum web gap stress for one truck loading 

LItS gsTwg 7.569961.1185.51.301   (6.11)

with R2 value is 0.96 

Maximum web gap stress for two trucks loading 

LItS gsTwg 4.22681504.141.302   (6.12)

with R2 value is 0.97  

where Δ1T= relative displacement between adjacent girders in one truck case (mm); 

Δ1T = relative displacement between adjacent girders in one truck case (mm); σwg1T = 

maximum web gap stress in one truck case (MPa); σwg2T = maximum web gap stress 

in two trucks case (MPa); L = span length (m); S = girder spacing (m);  ts = slab 

thickness (m); and Ig = girder stiffness (m4). 

The equation is only applicable for three girder bridges with two lanes. The 

formula is applicable for the bridge having the girder spacing between 2.1 m and 3 m, 

the length between 18 m and 36 m, the slab thickness between 210 mm and 300 mm, 

and the girder stiffness between 1.0 × 1010 mm4 and 1.7 × 1010 mm4. 

 



CHAPTER VII 

 

SUMMARY AND CONCLUSION 

 

7.1 Summary and Conclusions 

Dual-level finite element analyses incorporating both the  global model, which 

encompasses the entire bridge, and submodel which encompasses a portion of bridge 

surrounding the studied diaphragm were performed in the present research project. In 

order to validate the finite element model, truck loading test composite I-girder bridge 

has been applied and the data was collected. A total 15 global models and 4 

submodels were generated in this study. The multistep analysis was performed to 

validated the finite element model. A total of 108 cases for global model and sub 

model was validated by longitudinal stress in the bottom flange and web gap stress.  

Finite element analysis was performed in the parametric study. The bridge 

parameters which influence lateral load distribution factor are used. The parametric 

study method is varying the one parameter while another parameter is fixed. The main 

results from the parametric study are: 

 The maximum relative displacement increases as the bridge length and girder 

spacing increase. In contrast, it decreases with increasing slab thickness and 

girder stiffness. 

 For one truck loading, relative displacement between adjacent girders occurred 

under loaded and unloaded lane is the same and for two truck case, outer-inner 

transverse combination shows the critical combination. In this transverse 

combination, the critical relative displacement occurred under truck in the inner 

side.  

 The maximum vertical web gap stress occurred in the end of stiffener in one truck 

case and two truck case shows the stress in near the bottom flanges is more 

critical.  

 Lateral load distribution factor from the parametric study shows similar trend 

with both the AASHTO LRFD equation and previous study from Zokaie (2000). 

 For Wongsawang bridge, AASHTO and Thai trucks yielded similar lateral load 

distribution factor and web gap stress.  
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The ranking influencing bridge parameters can be summarized in Table 7.1. It 

shows the parameter affect based on the influenced to the relative displacement 

between adjacent girder, critical web gap stress, and lateral load distribution. 

Table 7.1. Ranking influencing bridge parameters 

Relative displacement Critical web gap stress LDF 

One truck Two truck One truck Two truck One truck Two truck

Bridge length Bridge length Girder stiffness Bridge length Girder spacing Girder spacing 

Slab thickness Girder spacing Bridge length Girder stiffness Bridge length Bridge length 

Girder spacing Slab thickness Slab thickness Girder spacing Slab thickness Slab thickness 

Girder stiffness Girder stiffness Girder spacing Slab thickness Girder stiffness Girder stiffness 

 

The parametric study shows that the relative displacement and vertical web 

gap are linear function of the bridge parameter. Subsequently, the multiple linear 

regressions was chosen to generate the formulation of maximum relative displacement 

and vertical web gap stress. The empirical formula from parametric study is listed 

below: 

Relative displacement between adjacent girders under one truck loading 

LItS gsT 47.005.17856.1449.187.51  (7.1)

Relative displacement between adjacent girders under two trucks loading 

LItS gsT 27.069.10237.994.104.62  (7.2)

Maximum web gap stress under one truck loading 

LItS gsTwg 7.569961.1185.51.301   (7.3)

Maximum web gap stress under two trucks loading 

LItS gsTwg 4.22681504.141.302   (7.4)

where Δ1T = relative displacement between adjacent girders in one truck case (mm); 

Δ1T = relative displacement between adjacent girders in one truck case (mm); σwg1T = 

maximum web gap stress in one truck case (MPa); σwg2T = maximum web gap stress 
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in two trucks case (MPa); L = span length (m); S = girder spacing (m);  ts = slab 

thickness (m); and Ig = girder stiffness (m4). 

The equation is only applicable for composite I-steel girder which has similar 

dimension and behavior with Wongsawan bridge. The range of applicability is as 

follows. The girder spacing between 2.1 m and 3 m, the length between 18 m and 36 

m, the slab thickness between 210 mm and 300 mm, and the girder stiffness between 

1.0 × 1010 mm4 and 1.7 × 1010 mm4. 

7.2 Suggestion for Future Work 

The suggested future work are briefly explained as follows: 

 Fatigue crack can be occurred in the stiffener-to-flange weld. This crack shows 

there is other critical location in the connection which is cannot be modeled in 

the finite element model in this research. Furthermore, the more appropriate 

and better model is needed to modeling the crack in this area. 

 Skew of angle parameter was excluded in this research. The research in effect 

angle of skew influence to the distortion induced stress is needed to 

investigate. 

 The simple equation of critical web-gap stress can be obtained from relative 

displacement between adjacent girders.  

 Real bridge dimension can be used to obtain more accurate formula of critical 

web gap stress. 



APPENDIX A 

 

CONSTRUCTION of GLOBAL MODEL 
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Material properties 

 Concrete 

o Modulus of elasticity = 24000 MPa 

o Poison ratio = 0.2 

 Steel 

o Modulus of elasticity = 200000 MPa 

o Poisson ratio = 0.3 

Member properties 

 Concrete thickness = 240 mm 

 Girder = I-14504501222 

 Diaphragm = I-6782401216 

 

Multistep analysis 

 

Six lane of truck moving load 

HS20-44 was applied to each line simultaneously to get the transverse position and 

longitudinal position which is result critical relative displacement between adjacent girders. 

Two truck case is considered.  

 

SAP2000 modeling 

1. Click the File menu > New model command to access the New Model form 

2. Click the drop-down list to set the unit to  

3. Click on the Blank  to access the Blank windows. It mean the model will not use 

the template from SAP2000 

4. Click the Define menu > Coordinate systems/Grids command to access the 

Coordinate/Grid System form. 

5. In that form click the Modify/Show System button to access the Define Grid Data form. 

Fill in the form as shown in figure A-1. Type values in the Grid ID and Ordinate cells; 
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click the Line Type, Visibility, and Bubble Loc. Cells until the appropriate option 

appears: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure A-1 

 Click the OK button on the Define Grid Data and Coordinate/Grid Systems form to 

exit the forms. 

6. Click the Define menu > Frame Section to access the Frame Properties form. In that 

from: 

 Click the Add New Property button to display the section Add Frame Section 

Frame Property form. After Select Property Type, click I/Wide Flange button  

to access the I/Wide Flange Section form. Fill in the form based on girder and 

diaphragm member properties, as shown in figure A-2 and figure A-3. 
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                                  Figure A-2                         Figure A-3 

 Click the OK button on the I/Wide Flange Section form to exit the forms. 

7. Click the Define menu > Area Section to access the Area Section form. In that from: 

 Click the drop down list in Select Section Type To Add to change to  

 Click the Add New Section to access the Shell Section Data form. Fill in the form 

based on the material and member properties, as shown in figure A-4. 

 

         Figure A-4 
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8. Click the Define menu > Link/Support Properties to access the Link/Support 

Properties form. In that from: 

 Click the drop down list in Link/Support Type to change to  

 Fill in the Property Name edit box 

 Couple all the box in Directional Properties area, as shown in figure A-5 

 

 

 Figure A-5 

 

9. Click the Set Default 3D View to change to the default 3-d view in the right 

windows. 

10. In the left windows click View menu > Set 2D View to access Set 2D View form. Fill in 

Z = -845 in XY plane  

11. Click the Quick Draw Frame/Cable/Tendon button  or click the Draw menu > 

Quick Draw Frame/Cable/Tendon command to access the Properties ob Object form. 

By default, the line Object Type should be Straight frame. Click the Section Box to 

display the drop-down list and click on the frame section which is defined before. 
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Connect the intersection as shown in figure A-6. Girder section was applied to the frame 

member number 1 until 11 and diaphragm section for frame number 12 until 21. 

                       

 

Figure A-6 

 

12. In the left windows click View menu > Set 2D View to access Set 2D View form. Fill in 

Z = 0 in XY plane  

13. Click the Quick Draw Rectangular Area Element button   or click the Draw menu 

> Draw Rectangular Area Element command to access the Properties ob Object form. 

Click the Section box to display the drop-down list and click on the frame section which 

is defined before. Click slab section which is defined before. 16 rectangular shell 

elements display is shown in figure A-7. 
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Figure A-7 

14. Click the Set Select Mode button to exit Draw Mode and enter Select Mode 

15. Click on all Girder section frame to divide the frames. Click Edit menu > Edit Lanes > 

Divide Frames command to access the Divide Selected Frames form. Verify that this 

form is filled as shown in figure A-8. 

 

Figure A-8 

 

16. Select all shell inside the external girder. Click Edit menu > Edit Areas > Divide Areas 

command to access the Decide Selected Frames form. Type 5 in the box of Along Edge 

from point 1 to 3, as shown in figure A-9. 
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Figure A-9 

 

17. Select all shell elements. Click Edit menu > Edit Areas > Divide Areas command to 

access the Decide Selected Frames form. Type 10 in the box of Along Edge from point 1 

to 2, as shown in figure A-10. 

 

Figure A-10. 
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18. Click the Draw menu > Draw 2 Joints Link command to access the Properties Object 

form. Select link properties name in the drop-down Properties in the form. Connect the 

node of Girder section frame and Slab shell element in every 1200 mm. 

19. Select three nodes in the end left of girder. Click Assign menu > Joint > Restraint to 

access Joint Restraint form. Coupled Translation 1, Translation 2, and Translation 3 and 

press OK. Select three nodes in the end right of girder. Click Assign menu > Joint > 

Restraint to access Joint Restraint form. Coupled Translation 3 and press OK. All 

restrain is shown in figure A-11. 

 

 

 

 

 

 

 

Figure A-10. 

 

20. The finite element model is ready. Totally, it has 746 point, 130 frame element, 480 area, 

and 63 Links. 

21.  Click Bridge menu > Layout Lines to access Define Bridge Layout Line form. Click 

Add New Line to access Bridge Layout Line Data form, as shown in figure A-11. Type 

24000 in the End Station edit box. Click OK button to return to the Define Bridge Layout 

Line form. Click OK button to exit all form. 
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Figure A-10. 

 

22. Click Bridge menu > Lanes to access Define Lanes form. In that form: 

 Click Add New Lane Defined From Layout Line to access Define Lane Data form. 

In the form: 

o Type OL in the Lane Name edit box 

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 1 in the Station edit box 

o Type -2100 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 24000 in the Station edit box 

o Type -2100 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Click OK button to return to the Define Lane form 

 Click Add New Lane Defined From Layout Line to access Define Lane Data form. 

In the form: 

o Type ML in the Lane Name edit box 

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 1 in the Station edit box 
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o Type -1500 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 24000 in the Station edit box 

o Type -1500 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Click OK button to return to the Define Lane form 

 Click Add New Lane Defined From Layout Line to access Define Lane Data form. 

In the form: 

o Type IL in the Lane Name edit box 

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 1 in the Station edit box 

o Type -900 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 24000 in the Station edit box 

o Type -900 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Click OK button to return to the Define Lane form 

 Click Add New Lane Defined From Layout Line to access Define Lane Data form. 

In the form: 

o Type OR in the Lane Name edit box 

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 1 in the Station edit box 

o Type 2100 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 24000 in the Station edit box 

o Type 2100 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  
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o Click OK button to return to the Define Lane form 

 Click Add New Lane Defined From Layout Line to access Define Lane Data form. 

In the form: 

o Type MR in the Lane Name edit box 

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 1 in the Station edit box 

o Type 1500 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Select Bridge Layout lane drop down list set to BLL1 

o Type 24000 in the Station edit box 

o Type 1500 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Click OK button to return to the Define Lane form 

 Click Add New Lane Defined From Layout Line to access Define Lane Data form. 

In the form: 

o Type IR in the Lane Name edit box 

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 1 in the Station edit box 

o Type -900 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Select Bridge Layout Lane drop down list set to BLL1 

o Type 24000 in the Station edit box 

o Type -900 in the Centerline Offset edit box 

o Type 1800 in the Lane Width edit box 

o Click the Add button.  

o Click OK button to return to the Define Lane form 

23. Click Bridge menu > Vehicles to access Define Vehicles form. In that form click the 

drop-down list in the Choose Vehicle Type to Add area and select Add Standard Vehicle. 

Click the Add Vehicle button to access the Standard Vehicle Data form. In that list 

 In the Data Definition area, select HSn-44 in the Vehicle Type drop down list. 

 Type 20 in the Scale Factor edit box if it is not already entered. 

 Click OK button to return to the Define Vehicles form 
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24. Click Defined menu > Load Case command to access the Define Load form. In that 

form: 

 Type O-O in the Load Name edit box. In the Type drop-down list set to Bridge Live. 

Click the load list, click Modify Bridge Live Load button to access Multi Step 

Bridge Live Load Generation form. In this form: 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select OL in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Click Add 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select OR in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Type 24000 in the Duration of Loading edit box 

o Type 100 in the Discrete Load Every edit box 

o Click OK to return to de Define Load form 

 Type O-M in the Load Name edit box. In the Type drop-down list set to Bridge Live. 

Click the load list, click Modify Bridge Live Load button to access Multi Step 

Bridge Live Load Generation form. In this form: 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select OL in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Click Add 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select MR in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Type 24000 in the Duration of Loading edit box 

o Type 100 in the Discrete Load Every edit box 

o Click OK to return to de Define Load form 
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 Type O-I in the Load Name edit box. In the Type drop-down list set to Bridge Live. 

Click the load list, click Modify Bridge Live Load button to access Multi Step 

Bridge Live Load Generation form. In this form: 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select OL in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Click Add 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select IR in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Type 24000 in the Duration of Loading edit box 

o Type 100 in the Discrete Load Every edit box 

o Click OK to return to de Define Load form 

 Type M-M in the Load Name edit box. In the Type drop-down list set to Bridge Live. 

Click the load list, click Modify Bridge Live Load button to access Multi Step 

Bridge Live Load Generation form. In this form: 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select ML in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Click Add 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select MR in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Type 24000 in the Duration of Loading edit box 

o Type 100 in the Discrete Load Every edit box 

o Click OK to return to de Define Load form 
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 Type M-I in the Load Name edit box. In the Type drop-down list set to Bridge Live. 

Click the load list, click Modify Bridge Live Load button to access Multi Step 

Bridge Live Load Generation form. In this form: 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select ML in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Click Add 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select IR in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Type 24000 in the Duration of Loading edit box 

o Type 100 in the Discrete Load Every edit box 

o Click OK to return to de Define Load form 

 Type I-I in the Load Name edit box. In the Type drop-down list set to Bridge Live. 

Click the load list, click Modify Bridge Live Load button to access Multi Step 

Bridge Live Load Generation form. In this form: 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select IL in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Click Add 

o Select Vehicle HS20-44 in the Vehicle drop-down list 

o Select IR in the Lane drop-down list 

o Accept the Start Dist and Start Time equal to zero 

o Select Forward in the Direction drop-down list 

o Type 1 speed in the Speed edit box 

o Type 24000 in the Duration of Loading edit box 

o Type 100 in the Discrete Load Every edit box 

o Click OK to return to de Define Load form 
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25. Click Analyze Menu > Set Analysis Options Command to access the Analysis Option 

form. In that form click the Space Frame button  to set the available degree of 

freedom and click the OK button 

26. Click the Run Analysis button  to display the Set Analysis Cases to Run form. In that 

form: 

 Verify that O-O, O-M, O-I, M-M, M-I, and I-I Case Name are set to Run in the 

Action List. 

 Click the Run Now button to run the analysis. 

27. When the analysis is complete and if there is no warning or error, click OK to close the 

window.  
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APPENDIX B 

 

CONSTRUCTION of SUBMODEL 

 

   

 

 

Longitudinal section 

 

 

 

Section A – A 

 

Detail B 
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Material properties 

 Steel 

o Modulus of elasticity = 200000 MPa 

o Poisson ratio = 0.3 

 

Member properties 

 Girder = I-14504501222 

 Diaphragm = I-6782401216 

 

SAP2000 modeling 

1. Click the File menu > New model command to access the New Model form 

2. Click the drop-down list to set the unit to  

3. Click on the Blank  to access the Blank windows. It mean the model will not use 

the template from SAP2000 

4. Click the Define menu > Coordinate systems/Grids command to access the 

Coordinate/Grid System form. 

5. In that form click the Modify/Show System button to access the Define Grid Data form. 

Fill in the form as shown in figure A-1. Type values in the Grid ID and Ordinate cells; 

click the Line Type, Visibility, and Bubble Loc. Cells until the appropriate option 

appears: 
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Figure B-1 

6. Click the Quick Draw Rectangular Area Element button   or click the Draw menu 

> Draw Rectangular Area Element command to access the Properties ob Object form. 

Click the Section box to display the drop-down list and click on the frame section which 

is defined before. Click slab section which is defined before. 16 rectangular shell 

elements display is shown in figure B-2. 
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Figure B-2 

7. Select all nodes in the top flange of girder. Click Assign menu > Joint > Restraint to 

access Joint Restraint form. Coupled Translation 2, Rotation 1, and Rotation 3 and press 

OK. Select all nodes in the top flange of girder which will applied by displacement 

loading (called: loaded node). Click Assign menu > Joint > Restraint to access Joint 

Restraint form. Coupled Translation 2, Translation 3, Rotation 1, and Rotation 3 and 

press OK. Select all nodes in the bottom flanges girder in the right end. Click Assign 

menu > Joint > Restraint to access Joint Restraint form. Coupled Translation 1, 

Translation 2, and Rotation 1and press OK. Select all nodes in the bottom flanges girder 

in the left end. Click Assign menu > Joint > Restraint to access Joint Restraint form. 

Coupled Translation 2, and Rotation 1and press OK.. All restrain is shown in figure B-3, 

figure B-4, and figure B-5. 
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Figure B-3 

 

   

 

 

 

 

Figure B-4 
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Figure B-5 

8. Click Defined menu > Load Case command to access the Define Load form. In that 

form type T in the Load Name edit box. In the Type drop-down list set to Live. 

9. Select loaded lane. Click Assign menu > Joint Load > Displacement to access Ground 

Displacement form. In this form type The Translation Global Z edit box with vertical 

displacement output from global model. Repeat it until all loaded node is applied by 

vertical displacement load.   

10. Click Analyze Menu > Set Analysis Options Command to access the Analysis Option 

form. In that form click the Space Frame button  to set the available degree of 

freedom and click the OK button 

11. Click the Run Analysis button  to display the Set Analysis Cases to Run form. In that 

form: 

 Verify that O-O, O-M, O-I, M-M, M-I, and I-I Case Name are set to Run in the 

Action List. 

 Click the Run Now button to run the analysis. 

12. When the analysis is complete and no warning or error, click OK to close the window.  
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